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1 Overview 

1.1 Benefits 

Â Easy Backup of 
1. Microsoft Exchange Server 2000 / 2003 
2. Microsoft SQL Server 7.0 / 2000 
3. Lotus Domino/Notes 5.0 or above 
4. Oracle 8i or above 
5. MySQL 3.2.4 or above 
6. Windows System State 
7. Outlook and Outlook Express (i.e. *.pst, *.dbx and *.wab) 
8. Important personal settings, e.g. Desktop, Favorite, My Documents and History etc 
9. Other common files (e.g. *.doc, *.xls) 

Â Support backing up only changes within a file (using in-file delta technology) 
Â Support backing up of open files on Windows XP/2003 (Volume Shadow Copy) 
Â Support backing up of Windows NTFS access privileges, Linux access privileges and modes, Mac OS 

X metadata and resource forks 
Â Easy to use, deploy and maintain 
 

1.2 Features 

Â (New in 5.2) Full support of Microsoft Exchange individual email, contacts, calendars, tasks etc. 
Â (New in 5.2) Choose whether to restore “file permissions” during restore. 
Â (New in 5.2) For “Local Copy” backup, ability to choose whether to perform a local copy backup only 

and skip the offsite backup. 
Â (New in 5.2) Lotus Notes/Domino agent for Linux. 
Â (New in 5.2) Auto Upgrade Agent to automatically upgrade the client software. 
Â User configurable incremental / differential in-file delta backup mode (i.e. backing up only changes 

within a file since the last incremental or full backup according to each user’s preference). 
Â Allow in-file delta backup mode to be overridden by each user individually according to backup time 

(e.g. enforcing full (or incremental or differential) backup of all files every Sunday or the 1
st
 day of 

every month). 
Â Volume Shadow Copy backup (i.e. backing up files even when they are exclusively open, e.g. 

Outlook.pst). 
Â In-File Delta backup (i.e. backing up only changes within files). 
Â Off-line backup mode and logout backup reminder. 
Â Customizable backup schedule allows backups to be scheduled at any time. 
Â Compress and encrypt data automatically before sending them to the server (server stores only 

encrypted data). 
Â Increment backup strategy ensures that only new or updated files are sent to the backup server. 
Â Support both full backup (database backup) and incremental backup (transaction log backup) for 

Microsoft SQL Server 7.0/2000, Microsoft Exchange Server 2000/2003, Lotus Domino/Notes 5.0 and 
Oracle 8i or above. 

Â Can integrate with external “Open File Manager” to provide open file backup support to all open files. 
Â Access backup data anytime, anywhere by using a web browser. 
Â Comprehensive backup report lists all files backed up. Backup report delivered automatically via email. 
Â Backup data are CRC validated before they are stored on server. 
Â Fully user customizable data retention policy allows users to have access to deleted files using the 

least possible storage space on the backup server. 
Â Can select source backup files easily by using a backup filter, e.g. selecting all *.doc and *.xls in your 

computer in a single operation. 
Â Run any custom OS commands before/after a backup job. 
Â Run on Windows, Mac OS X, Linux, NetWare, Unix and all other platforms supporting a Java2 

Runtime Environment. 
Â Periodic backup files validation on backup server ensures backup files are 100% valid and fully 

restorable when needed. 
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1.3 Security 

Â 128-bit point-to-point SSL communication between server and client 
Â Support HTTP/HTTPS Proxy and Socks v4/v5 firewall  
Â Data are 128-bit encrypted when stored on the backup server 
Â Choice of different encryption algorithms, e.g. Twofish, Triple DES, Advanced Encryption Standard 

(AES) 
Â Choice of different encryption modes, e.g. Electronic Cook Book (ECB) and Cipher Block Chaining 

(CBC) 
Â An random initializing vector, salt and iteration count will be generated by the software automatically 

for each file when encrypting your data 
Â Each backup user can restrict online access to his files to his pre-defined list of IP addresses 

 

1.4 System Requirements 

Server Software ( OBS )  

Â Operating System: 
1. Windows 2000 / XP / 2003 * 
2. Linux kernel 2.2 or above ** (e.g. RedHat Linux 6.x or above, though the use of Linux kernel 

2.6.9-34 or above is recommended) 
3. Mac OS X 10.2 or above 
4. All other operating systems that supports Java2 Runtime Environment 1.4.1 or above 

Â Memory: 128MB (minimum), 512MB (recommended) 

Â Disk Space: 250MB  

Â Network Protocol: TCP/IP (http/https)  
 
* The use of Windows 2000 WorkStation and XP Professional is only recommended for backup system with less 
than 20 users. For 20 or more users, please use Windows 2000 or 2003 Server instead. 

 

Client Software ( OBM )  

Â Operating System: 
1. Windows 95 / 98 / ME / NT / 2000 / XP / 2003 
2. Linux kernel 2.2 or above ** (e.g. RedHat Linux 6.x or above, though the use of Linux kernel 

2.6.9-34 or above is recommended) 
3. Solaris 2.x or above 
4. Mac OS X 10.2 or above 
5. NetWare 5.1 or above (with Perl v5.8.4 or above) 
6. All other operating systems that supports Java2 Runtime Environment 1.3.1 or above 

Â Memory: 128MB (minimum), 256MB (recommended) 

Â Disk Space: 100MB  

Â Network Protocol: TCP/IP (http/https) 
 
** Standard C++ libraries for backwards compatibility compiler (compat-libstdc++-x.x-y.y.y.y.i386.rpm) must be 
installed if you are not using a Linux 2.2 kernel. These libraries are required to run all Java applications. 
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2 Installing G-OBM 

Before you can start backing up data to the Gigasoft Offsite Backup Server, you need to install the Gigasoft 
Online Backup Manager (G-OBM) client onto your computer. 

2.1 Installing G-OBM for Windows 

1. Download the Gigasoft Online Backup Manager installer from our website. 

2. Double click the icon to run the installer. 

3. Follow on screen instructions. 

4. After installation, G-OBM will start automatically. 
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2.2 Installing G-OBM for Mac OS X 

1. Download the Gigasoft Online Backup Manager installer from our website. 

2. Expand the zip file. 

3. Double click the pkg file icon to run the installer. 

4. Follow on screen instructions. 

5. After installation, the installer will need to restart your computer . 

6. After restarting your computer, click the newly added G-OBM icon on your desktop. You can manually 
drag the icon to your dock bar if you wish. 

2.3 Installing G-OBM for Linux 

1. Download the Gigasoft Online Backup Manager tarball release from our website. 

2. Set the OBM_HOME environment variable 
 
# export OBM_HOME=/usr/local/obm 

3. Expand the client software to $OBM_HOME 
 
# mkdir $OBM_HOME 
# tar ïx ïC $OBM_HOME -zvf obm-linux.tar.gz 

4. Install G-OBM 
 
# cd $OBM_HOME 
# ./bin/install.sh 

5. Start Auto Upgrade Agent 
 
# /etc/init.d/auaobm start 

6. Start backup scheduler 
 
# /etc/init.d/obm-scheduler start 

7. Set the DISPLAY environment variable 
 
# export DISPLAY=IP_ADDRESS_OF_XTERMINAL[:0.0] 

8. Run G-OBM 
 
# sh $OBM_HOME/bin/BackupManager.sh & 
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2.4 Installing G-OBM for Netware 

1. Download the Gigasoft Online Backup Manager zip release from our website. 

2. Expand the zip file to SYS:\OBM 

3. Install G-OBM 
 
SYS:\> SYS:\OBM\aua\bin\install-aua.ncf 

4. Start Auto Upgrade Agent 
 
SYS:\> SYS:\OBM\aua\bin\startup.ncf 

5. Start backup scheduler 
 
SYS:\> SYS:\OBM\bin\Scheduler.ncf 

6. Run G-OBM 
 
SYS:\> SYS:\OBM\bin\BackupManager.ncf 

2.5 Installing G-OBM for Sun Solaris 

1. Download the Gigasoft Online Backup Manager tarball release from our website. 

2. Set the OBM_HOME environment variable 
 
# export OBM_HOME=/usr/local/obm; export OBM_HOME 

3. Set the JAVA_HOME environment variable to the directory where J2SE Java Runtime Environment (JRE) 
1.4.x has been installed 
 
# export JAVA_HOME=/usr/java/j2re1.4.x; export JAVA_HOME 

4. Expand the client software to $OBM_HOME 
 
# mkdir $OBM_HOME 
# cd $OBM_HOME 
# gunzip -c obm-solaris.tar.gz | tar ïxf - 

5. Install G-OBM 
 
# ./bin/install.sh 

6. Start Auto Upgrade Agent 
 
# /etc/init.d/auaobm start 

7. Start backup scheduler 
 
# /etc/init.d/obm-scheduler start 

8. Set the DISPLAY environment variable 
 
# export DISPLAY=IP_ADDRESS_OF_XTERMINAL[:0.0] 

9. Run G-OBM 
 
# sh $OBM_HOME/bin/BackupManager.sh & 
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3 Uninstalling G-OBM 

This section describes the steps required to uninstall G-OBM from your computer. 

3.1 Uninstalling G-OBM for Windows 

1. Open [Start] -> [Control Panel]  -> [Add/Remove Programs] 

2. Select [G-OBM] from the list and press the [Remove] button 

 

3.2 Uninstalling G-OBM for Mac OS X 

1. Remove all program files by running 
 
# cd $OBM_HOME/bin 
# sudo ./uninstall.sh 

2. Remove all backup setting by removing ~/.obm 
 
# rm ïrf ~/.obm 

3. Restart your computer 

 

3.3 Uninstalling G-OBM for Linux 

1. Change user to ñrootò or equivalent 

2. Remove all program files by running 
 
# cd $OBM_HOME/bin 
# ./uninstall.sh 

3. Remove all backup setting by removing ~/.obm 
 
# rm ïrf ~/.obm 

 

3.4 Uninstalling G-OBM for Netware 

1. Stop the running backup scheduler by running 
 
SYS:\> touch SYS:\OBM\ipc\Scheduler\stop 

2. Stop the running auto upgrade agent by running 
 
SYS:\> SYS:\OBM\aua\bin\shutdown.ncf 

3. Remove all program files by removing the directory SYS:\OBM 

4. Remove all backup settings by removing the directory SYS:\.OBM 
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3.5 Uninstalling G-OBM for Solaris 

1. Change user to ñrootò or equivalent 

2. Set the OBM_HOME environment variable 
 
# export OBM_HOME=/usr/local/obm; export OBM_HOME 

3. Set the JAVA_HOME environment variable to the directory where J2SE Java Runtime Environment (JRE) 
1.4.x has been installed 
 
# export JAVA_HOME=/usr/java/j2re1.4.x; export JAVA_HOME 

4. Remove all program files by running 
 
# cd $OBM_HOME/bin 
# ./uninstall.sh 

5. Remove all backup setting by removing ~/.obm 
 
# rm ïrf ~/.obm 
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4 Using G-OBM 

This chapter will describe all the features available in G-OBM and outline how you can use G-OBM to meet various 
backup needs.  

4.1 System Tray Launcher (Windows Only) 

After you have successfully installed G-OBM onto your computer, a G-OBM icon will be added to the system tray 
area (next to your system clock) automatically.  

 

This icon is the entry point to G-OBM. Right clicking the icon will show a menu that provides the following 
functions: 

Menu Item  What it does  

Open Run G-OBM. 

Backup Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode. 

Backup and Logoff Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and then logoff from Windows when 
finished. 

Backup and Restart Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and restart Windows when finished. 

Backup and Shutdown Runs a specific backup set (or all backup sets) chosen from the sub-
menu in silent background mode and shutdown the computer when 
finished. 

Help Shows a help dialog 

Stop running backup Interrupts a running backup set (or all backup sets) chosen from the 
sub-menu. 

Exit Close this system tray launcher application. 
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4.2 Logon Dialog 

Before you can use G-OBM, you have to be authenticated by the Offsite Backup Server first. The logon dialog 
shown below will check if you have the right to access G-OBM by submitting the username and password you 
provided to the backup server. 

 

4.3 Language Selection 

You can switch the language of the G-OBM user interface by choosing the desired language available from the 
[Language] drop down list. The languages available includes English, Czech, Danish, Dutch, French, Spanish, 
Portuguese, Icelandic, Norwegian, Finnish, Italian, German, Swedish, Chinese (Traditional and Simplified), 
Japanese, Lithuanian and Slovenian. 

 

4.4 User Profile 

After the backup server authenticates you successfully, the G-OBM main window appears. You can then use G-
OBM to update your user profile. 
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You can perform the following update to your user profile. 

To change your [Password], press the [Change] button next to the password field. A Change Password dialog will 
appear. Enter your original password and new password into the text field of this dialog and press [OK].  
 

 

To change your [Display Name], press the [Change] button next to the display name field. A Change Display 
Name dialog will appear. Enter the new display name and press [OK].  
 

 

To change your [Time Zone], just select your time zone from the drop down list next to the time zone entry.  

To add a new contact email to this account, press the [Add] button in the [Contact] section. A [Add New Contact] 
dialog will appear. Enter a name and an email address in the text field provided and then press the [OK] button. 
 

 

To remove a contact email, select the email that is to be removed from the email list and press the [Remove] 
button. Press [OK] to confirm the removal. 

To update a contact email, select the email that is to be updated from the email list and press the [Properties] 
button. A [Update Contact Property] dialog will appear. After you have made the changes that you want, press 
the [OK] button. 
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4.5 Backup Logs 

All backup activities are logged to backup activity log files. They are available for reviewing from G-OBM. 

How to review backup activities?  

You can review all your backup Jobs by  

1. Select the [Log] tab available at the bottom of G-OBM 

2. Select the Backup Job you want to review on the [Log Controller] panel 
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5 Setting Up Backup Sets 

A backup set contains all backup settings of a backup operation. This section will describe all features available 
within a backup set and explain how you can use each of them to achieve various tasks.  

Each backup account can have multiple backup sets. Each backup set is an individual and independent entity. For 
example, if you want one directory to be backed up during the day and another directory to be backed up during 
the night, you can create two backup sets, each with a different backup schedule and backup source, to serve 
this need. 

To create a new backup set, simply click [Backup Set] -> [New] and choose a backup set type. For example, letôs 
create a ñFile Backup Setò for the rest of this chapter. 

 

5.1 Backup Set Type 

A backup set can be of one of the following types: 

Backup Type  Description  

File  Backup set type to backup common files/directories 

Microsoft SQL Server Backup set type to backup Microsoft SQL Server 7.0/2000 

Oracle Database Server Backup set type to backup Oracle 8i/9i database 

Lotus Domino/Notes Backup set type to backup Lotus Domino/Notes  

Microsoft Exchange Server Backup set type to backup Microsoft Exchange Server 2000 / 2003  

MySQL Backup set type to backup MySQL Server 

System State Backup set type to backup Microsoft Windowôs System State 

Microsoft Exchange Mail 
(MAPI) 

Backup set type to backup individual emails, contacts, calendars, 
tasks etceteras from Microsoft Exchange Server 2000 / 2003 

 

Backup set type is defined at backup set creation and cannot be modified. If you want to change the backup set 
type, you have to create another backup set in the new backup set type.  

 

5.2 Backup Source 

A ñBackup Sourceò defines the files/directories that are to be included in a backup set. There are two types of 
backup source: Selected and Deselected. Selected backup source defines files/directories that are to be included 
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in a backup set while deselected backup source defines files/directories that are to be excluded from a backup set. 
Online Backup Manager will generate appropriate backup source setting for you automatically when you make 
your backup source selection on G-OBM. 

Please note that for Windows operating systems, if the ñHide protected operating files (Recommended)ò setting is 
enabled for the file explorer, system folders/files will not be shown in the backup source. By selecting the parent 
folders however, all subfolders (including system folders/files) will be included in the backup set. Thus if you want 
to exclude system folders (e.g. recycle bin) from the backup, please select the desired folders/files directly rather 
than selecting the parent folder. Alternatively, you can enter the corresponding system path to the [Exclude List] 
of the backup set using the web interface. 

 

From the [Standard] node available at the top of the [Backup Source] tree, you can easily select the following 
common folders to be backed up: 

1. ñMy Documentsò folder 

2. ñOutlookò and ñOutlook Expressò mail store folder 

3. ñFavoritesò folder 

4. ñDesktopò folder  

From the [Options] node available below the [Standard] node, you can easily select other common folders to be 
backed up as well. They include the ñApplication Dataò folder, the ñStart Menuò folder, the ñTemplatesò folder, the 
ñAll Usersô Documentsò folder, the ñTemporary Internet Filesò folder, the ñCookiesò folder, the ñFontò folder, the 
ñHistoryò folder, the ñApplications Dataò folder, the ñNethoodò folder, the ñPrinthoodò folder, the ñRecentò folder 
and the ñSend toò folder. 
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The checkbox next to the files/directories shown above can be in one of the following mode: 

Mode  Description  

 All files/directories (recursively) under this directory will be backed up 

 All files/directories (recursively), except those explicitly excluded, under this directory will 
be backed up. If you add files/directories to this directory in the future, they will be 
backed up as well. 

 Only the checked files/directories under this directory will be backed up. If you add 
files/directories to this directory in the future, they will NOT be backed up. 

 Nothing under this directory will be backed up. 

  

 

5.3 Mapped Network Drive 

If you need to backup a mapped network drive on Windows (it will only work in Windows NT/2000/XP/2003), you 
must enter your Windowôs domain, username and password into the [Network Resources Authentication for 
Windows] section as shown below. It is required because scheduled backups will always run under the context of 
Windowôs ñLocal Systemò account (which does not have the privileges required to access network resources) by 
default. G-OBM needs to collect your Windows username, password and domain name to authenticate itself to the 
windows domain controller to acquire the required access privileges to the network files to be backed up. If you 
donôt supply a username and password, G-OBM will have problems accessing network resources in its scheduled 
backup Jobs. 

If you need to backup network mapped drive in scheduled backup, please do this: 

i. Select the backup set from the left panel and press the [Properties] button  

 

ii. Enter your Windows domain, username and password into the dialog shown below and press [OK] 
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iii. Press the [Save Setting] button on the toolbar 
 

The steps above apply only to computers running in a Windows domain. If you donôt have a windows domain with 
your network and you are using a workgroup or using a NetWare server, please use the ñnet useò command to 
authenticate the running backup process against the computer hosting the mapped drive. Otherwise, you will get 
ñAccess Deniedò error from the backup report. 

For example, if you want to backup \\SERVER\SHARE that is located on a NetWare server (or another computer 
in a windows workgroup) and you are getting "Network drive is not accessible" error message, please try adding 
the following command as a [Pre-backup command]  

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 

E.g. 

 

Enter one of the following commands directly into the Pre-Backup Command: 

net use \\Netware\Data password /USER:peter 
net use \\WorkgroupComputer1\Data password /USER:WorkgroupComputer1\peter 

This will authenticate the current process with the NetWare server (or another computer in a windows workgroup) 
and backup will then run correctly. 
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5.4 Backup Schedule 

A ñBackup Scheduleò defines the frequency and the time that backups should run automatically. 

 

Backup schedule can be in one of the following types: 

Type  Description  

Daily Backup Jobs will run everyday 

Weekly Backup Jobs will run on the specified day(s) of every week 

Monthly Backup Jobs will run on the specified day or on a day with a given criteria (e.g. first 
weekend, last weekday) of every month 

Custom Backup job will run once on any particular date 

 
For each schedule type above, backup will run at the scheduled time for a maximum of the duration specified (or 
until all data are backed up if [Stop on backup completion] option is chosen). If a backup job does not finish 
within the maximum duration specified, it will be interrupted. 

Please note that you can have more than one schedule within a backup set. For example, you can have a daily 
backup schedule that runs at 13:00 at noon and another daily backup schedule that runs at 00:00 at midnight. 
The combination of these schedules effectively creates a backup schedule that runs daily at 00:00 and 13:00 
every day. 

5.5 Backup Filter 

A ñBackup Filterò defines the file selection rules that allow user to easily include/exclude files into/from the 
backup set by applying user defined criteria(s) to the file names or directory names. 

There are some basic rules regarding backup filters: 

i. Filters are checked in creation order. Once inclusion/exclusion has been identified, the remaining 
filters won't be checked. 

ii. Inclusion/Exclusion made by filter always takes precedence over backup source selections 

iii. If all filters do not apply to a particular file, this file is then checked for inclusion/exclusion backup 
source selections 
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Key  Description  

Name The name of a filter 

Top Directory The top directory to which this filter is applied. Filtering rules will be applied to 
all files and/or directories under this directory. 

Apply To Define whether to apply the filtering rule to files and/or directories 

Pattern Matching It defines the filtering rules of a filter. A filtering rule can be of one of the 
following types: 
 
[Starts With] Include/Exclude all files/directories with name starting 

with a certain pattern.  
For example: You can use B* to match all files with 
name starting with a óBô character 

 
[Contains] Include/Exclude all files/directories with name 

containing a certain pattern.  
For example: You can use *B* to match all files with 
name containing with a óBô character 

 
[Ends With] Include/Exclude all files/directories with name ending 

with a certain pattern.  
For example: You can use *.doc to match all files with 
name ending with ó.docô (all Word documents) 

 
[Regular Expression] Include/Exclude all files/directories with name matching 

a regular expression.  
 

Filter Mode Defines whether you want to include or exclude matched files into/from the 
backup set. Also, for those unmatched files, you can choose to exclude (if 
include filter type) or include (if exclude filter type) them into/from the 
backup set.  

 
Example 1: 
If you want to backup only Word, Excel and PowerPoint documents in your document directory (e.g. C:\My 
Documents), you should setup your backup filter as follows. 

Top Directory  = C:\My Documents  
Apply To   = File (true) 
Matching Type = End With 
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Matching Patterns = *.doc, *.xls, *.ppt 
Filter Mode  = Include 
Exclude all others  = True 

Example 2: 
If you want to backup all files, excluding all *.exe, *.dll and *.tmp, in C:\Applications, you should setup your 
backup filter as follows. 

Top Directory  = C:\Applications 
Apply To   = File (true) 
Matching Type = End With 
Matching Patterns = *.exe,*.dll, *.tmp 
Filter Mode  = Exclude 
Include all others  = True 

Example 3: 
If you have made your selection of files (all under C:\) from the backup source setting but you want exclude all 
images (e.g. *.jpg and *.gif) from your selection, you should setup your backup filter as follows. 

Top Directory  = C:\  
Apply To   = File (true) 
Matching Type = End With 
Matching Patterns = *.jpg, *.gif 
Filter Mode  = Exclude 
Include all others  = false 

Please note that the [Include all others] setting is not enabled because you donôt want to include all other files 
(NOT *.jpg, *.gif) under C:\ into the backup set. 

Example 4: (advanced) 

If you want to include everything, except the ñlogò directory, under C:\Applications into a backup set, you should 
setup your backup filter as follows. 

Top Directory  = C:\Applications 
Apply To   = Directory (true) 
Matching Type = Regular Expression  
Matching Patterns = ^log$ 
Filter Mode  = Exclude 
Include all others  = True 

Example 5: (advanced) 

If you want to include all directories named ñlogò from the backup set files with file name starting with ñBò and 
ending with ñ*.docò under C:\My Documents into the backup set, you can use a regular expression of 
ñ̂ B.*\.doc$ò to do your selection. The filter backup can then be setup as follows. 

Top Directory  = C:\My Documents 
Apply To   = File (true) 
Matching Type = Regular Expression  
Matching Patterns = ^B.*\.doc$ 
Filter Mode  = Include 
Exclude all others  = True 

5.6 Pre/Post-Backup Command 

The ñCommand Line Toolò feature has two major components, the [Pre-Backup] command and the [Post-Backup] 
command. You can use the [Pre-Backup] or [Post-Backup] commands to run any native OS (operating system) 
commands before or after running a backup job.  
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Both [Pre-Backup] and [Post-Backup] commands comprise of the following parameters:  

Key  Description  

Name  Name of this Command 

Command The command to be run  
(e.g. C:\My Documents\Application.exe or C:\My Documents\BatchJob.bat) 

Working Directory The directory at which this command will run 

 
The backup set type affects the time at which [Pre-Backup] and [Post-Backup] commands run. The following 
table outlines when [Pre-Backup] and [Post-Backup] commands will run in different types of backup set. 

Backup Set Type  When Pre - Backup Commands run?  When Post - Commands run?  

File  Before uploading backup files After uploading all backup files 

Non-File Backup Sets 
(e.g. Microsoft SQL 
Server) 

Before spooling backup files to 
temporary directory 

After spooling backup files to 
temporary directory (i.e. before 
the first backup file is uploaded) 

 
Note: You should never backup an application while it is running as this can result in inconsistent and unusable 
files getting backed up. Please use the ñVolume Shadow Copyò feature if youôre running Windows XP/2003 or 
make use of the Pre-Backup Command feature to shutdown your application before running a backup job and use 
the Post-Backup Command feature to restart your application after the backup job has completed. 

For Example 

You want to stop Microsoft Outlook using the Pre-Backup Command and restart it after backup using the Post-
Backup Command, create the two following text files and assigned the files to Pre-Backup and Post-Backup 
Command. 

1. Create a text file named ñOutlookClose.vbsò using notepad with the following two lines: 

Set objOLK = createObject("Outlook.Application")  

objOLK.quit  
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2. Create a text file named ñOutlookStart.batò using notepad with the following line: 

"C: \ Program Files \ Microsoft Office \ OFFICE11\ OUTLOOK.EXE" 

5.7 Temporary directory 

If you are running a file backup job with in-file delta enabled or a database type backup job, G-OBM will generate 
temporary files and the directory that will be used to store all these files are defined by [Setting] -> [Temporary 
directory for storing backup files]. Please set this to a non-system disk partition that has enough free space to 
avoid problems. 

You can set the [Temporary directory for storing backup files] to a mapped network drive. If you choose to do 
this, please use a UNC path (e.g. \\SERVER\SHARE) and donôt forget to configure the [Backup Set] -> [Network 
Resources Authentication for Windows] setting. 

To conserve the use of disk space, you can set the [Remove temporary files after backup] option to delete the 
temporary files automatically after a backup job has finished. 

5.8 Transfer Block Size 

Transfer block size defines the block size G-OBM will use to transfer your backup blocks. Generally, backup jobs 
using a larger block size will have better performance, because of the smaller number of connections involved.  

However, some firewalls or proxy servers may block out-going network traffic (HTTP/HTTPS POST method) with 
large block size for security reasons. If you are in a network with this type of restriction, please lower the 
transfer size value and try again. 

To change the transfer block size of any backup set, please select the [Setting] node on the left panel to invoke 
the [Setting] panel on the right. You can then make changes to the [Transfer Block Size]. After you have made 
your changes, just press the [Save Setting] button on the toolbar. 

 

5.9 Follow Symbolic Link (Linux/Unix/Mac only) 

Under Unix/Linux/Mac, users can create a symbolic link to link a file/directory from another directory. This setting 
defines whether you want G-OBM to traverse any symbolic links encountered on your backup path. 

To change the follow symbolic link of any backup set, please select the [Setting] node on the left panel to invoke 
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the [Setting] panel on the right. You can then make changes to the [Follow Symbolic Link]. After you have made 
your changes, just press the [Save Setting] button on the toolbar. 

 

5.10 Microsoftôs Volume Shadow Copy Service (VSS) 

Microsoft Volume Shadow Copy Service (VSS) allows you to backup files that are exclusively opened. Without 
VSS, you will get the error message ñThe process cannot access the file because another process has locked a 
portion of the fileò if you are trying to backup a file that is exclusively opened (e.g. Outlook PST file).  

Please note that VSS is only available on Windows XP / 2003 and you must have administrative privileges to start 
the VSS service on a computer. Also VSS will only work if at least one of your partitions is formatted using NTFS. 

If you are running Windows 2003, please install the Windows 2003 VSS hot fix available in 
http://support.microsoft.com/default.aspx?scid=kb;en-us;887827 before running VSS. 

If you are running into problems with VSS running on Windows XP / 2003, Microsoft's recommendation is to try 
re-registering the Volume Shadow Copy Service again. Simply run the script [OBM Home]\bin\RegisterVSS.bat to 
do so. 

For more information, please take a look at the following page for a technical introduction to Volume Shadow 
Copy Services (VSS): 

http://technet2.microsoft.com/windowsserver/en/library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx 

5.11 Encryption 

Before your files are sent to the Gigasoft Offsite Backup Server, all your files are compressed and encrypted 
using your choice of encryption algorithm, mode and key. The following table explains all encryption parameters 
available within a backup set. 

Note: 
Encryption settings are set at backup set creation time and cannot be modified. You need to create a new backup 
set if you want to change your encryption settings for a backup set. 

 

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;887827
http://technet2.microsoft.com/windowsserver/en/library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx
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Parameter  Description  

Encryption Algorithm It defines the encrypting algorithm used to encrypt your backup files. There are 
three encryption algorithms available:  
 
[AES] Advanced Encryption Standard algorithm 
[DESede] Triple DES algorithm 
[Twofish] Twofish algorithm 
 
We recommend the use of AES as it has been chosen as the encryption standard 
for commercial use. Please refer to references on Cryptography for more 
information about encryption algorithms. 

Encryption Mode It defines the encrypting mode used to encrypt your backup files. There are two 
encryption modes available:  
 
[ECB] Electronic Cook Book Mode 
[CBC] Cipher Block Chaining Mode 

 
We recommend the use of CBC mode as it offers better security. Please refer to 
references on Cryptography for more information about encryption modes. 

Encrypting Key The key used to encrypt all files within a backup set. Please write it down on 
paper and keep it in a safe place. If the key is lost, you will not be able to 
recover  your files from the encrypted backup files.  

  

5.12 Retention Policy 

During backup, if G-OBM finds that you have deleted a file (or updated a file) on your computer, it will put the 
corresponding deleted (or updated) file already backed up on the backup server into a retention area. The 
retention policy setting defines how long files inside the retention area will be kept on the backup server before 
they are deleted automatically from the server. 

Retention policy will only affect ñretainedò file (i.e. files that have already been deleted or updated on your 
computer and thus are moved to the retention area of the backup server). For those files that have not been 
updated on your computer, the backup of these files is kept in the data area on the backup server and wonôt be 
affected by the setting of retention policy. These backup files of unchanged files will stay on the backup server 
forever until the original files are removed (or updated) from your computer. 

Standard Retention Policy  

The [Standard] retention policy allows you to delete retained files automatically after a user defined number of 
days or after a user defined number of backup Jobs. To change the retention policy setting of any backup set, 
please select the [Retention Policy] node on the left panel. You can then make changes to your retention policy 
under the [Retention Policy] section. After you have made your changes, just press the [Save Setting] button on 
the toolbar. 
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Advanced Retention Policy  

 
 

The [Advanced] retention policy allows you to configure a more flexible retention policy. It allows you to keep a 
set of snapshots of all backup files based on the time of the backup Jobs. For example, you can configure the 
advanced retention policy to keep the following sets of backup files to mimic the retention policy of the old days 
when you were still doing tape rotations: 

É All files available within the last 7 days 

É All files available on the last 4 Saturdays within the last 28 days 

É All files available on the 1st day of each month within the last 3 months 

É All files available on the 1st day of each quarter within the last 12 months 
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É All files available on the 1st day of each year within the last 7 years 

To do so, you need to setup your advanced retention policy as follows:  

É Type = Daily; Number of copy to keep = 7  

É Type = Weekly; Frequency = Saturday; Number of copy to keep = 4 

É Type = Monthly; Frequency = Day 1; Number of copy to keep = 3 

É Type = Quarterly; Frequency = Day 1 of Jan, Apr, Jul, Oct; Number of copy to keep = 4 

É Type = Yearly; Frequency = Date 01-01; Number of copy to keep = 7 

Assuming today is 17-Jan-2006, if [Remove retention files for overlap policy] is NOT enabled, a total of 22 
snapshots (provided you have run backups daily for more than 7 years) will be kept on the server accordingly, 
i.e.:  

Daily  Weekly  Monthly  Quarterly  Yearly  

16-Jan-2006 14-Jan-2006 01-Jan-2006 01-Jan-2006 01-Jan-2006 

15-Jan-2006 07-Jan-2006 01-Dec-2005 01-Oct-2005 01-Jan-2005 

14-Jan-2006 31-Dec-2005 01-Nov-2005 01-Jul-2005 01-Jan-2004 

13-Jan-2006 24-Dec-2005  01-Apr-2005 01-Jan-2003 

12-Jan-2006    01-Jan-2002 

11-Jan-2006    01-Jan-2001 

10-Jan-2006    01-Jan-2000 

 

If [Remove retention files for overlap policy] is enabled, only the following snapshots are kept: 

Daily  Weekly  Monthly  Quarterly  Yearl y  

16-Jan-2006 14-Jan-2006 01-Jan-2006 01-Jan-2006 01-Jan-2006 

15-Jan-2006 07-Jan-2006 01-Dec-2005 01-Oct-2005 01-Jan-2005 

14-Jan-2006 31-Dec-2005 01-Nov-2005 01-Jul-2005 01-Jan-2004 

13-Jan-2006 24-Dec-2005  01-Apr-2005 01-Jan-2003 

12-Jan-2006    01-Jan-2002 

11-Jan-2006    01-Jan-2001 

10-Jan-2006    01-Jan-2000 

 

The weekly policy overrides the daily policy so the snapshots of 10-Jan-2006, 11-Jan-2006, 12-Jan-2006, 13-
Jan-2006 and 14-Jan-2006 are removed. The monthly policy overrides the weekly policy so the snapshots of 24-
Dec-2005 and 31-Dec-2005 are removed. The same applies to the monthly, quarterly and yearly policy giving a 
total of 11 snapshots. 
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5.13 Extra Backup (Off-line backup, Logout Reminder) 

Off-line backup is basically designed for notebook users who are off-line most of the time and cannot rely on the 
backup schedule to backup regularly. The "Backup Interval" allows notebook users to specify the interval that 
they would like their data to backup. When the machine is online and this interval has elapsed, backup will run 
automatically. If ñBackup Alertò is enabled, a popup message box will ask the user to confirm starting the backup. 

The "Email Notification" setting is the number of days since the last backup that triggers the backup server to 
send email notification to the client to remind him to run an off-line backup. 

When the ñLogout Reminderò setting is enabled, a popup message box will ask the user to start a backup before 
logging out / shutting down Windows. 

 

5.14 In-File Delta 

Please refer to the in-file delta section for more information on this topic.  

5.15 Local Copy 

If you want to save an extra copy of backup data on your local hard disk (in addition to a copy of backup data 
stored on the backup server) to minimize file-restoring time and/or to provide an extra safety precaution, you 
can do the following: 

i. Open G-OBM from the System Tray (see previous sections for details) 

ii. Setup your backup set (see previous sections for details) 

iii. Select [Local Copy] under your backup set from the left panel  
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iv. Check the [Copy to Local Hard Disk] checkbox 

v. Enter a directory to where you want an extra copy of your backup files to be stored in the [Copy to] 
field provided (preferably a directory under another hard disk) 

vi. (Optional) Select the [Yes] radio button if you want to store your backup files in compressed form to 
conserve free space usage 

vii. An extra copy of backup will be saved in the [Copy to] directory when you run your backup job  

If you want to make local copy to a directory located on a NetWare server (or another computer is a windows 
workgroup) and you are getting "Network drive is not accessible" error message, please try adding the following 
command as a [Pre-backup command]  

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 

E.g. 

C:\> net use \\Netware\Data password /USER:peter 
C:\> net use \\WorkgroupComputer1\Data password /USER:WorkgroupComputer1\peter 

This will authenticate the current process with the NetWare server (or another computer is a windows workgroup). 
Backup will then be allowed to run correctly. 

How to restore ñLocal Copy ò files  

ñLocal Copyò files are stored in the [Copy to] directory (under [Local Copy] setting). To restore backup files, 
please do the followings: 

i. Choose [Tools] -> [Unzip Local Copy] 

ii. Select the required [Backup Set] from the drop down list 

iii. Fill in the [Source Directory] (directory where ñLocal Copyò files are stored) and [Destination 
Directory] (directory to where you want ñLocal Copyò files to be restored) 
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iv. Click [Start] 

5.16 Using One Backup Account for Multiple Computers  

G-OBM allows you to backup multiple computers using a single backup account. To backup multiple computers, 
you need to create a different backup set to backup each individual computer and to configure the [Run 
scheduled backup on this computer] checkbox. 

 

For version 5.2  

Since the computer that created the backup set will have its computer name associated with the backup set. The 
backup scheduler running on each computer will only run backup sets with the same computer name as itself. 
Thus, you just need to make sure that all your computer names using a single backup account are unique. 

For version 5.1 or Earlier  

You must configure G-OBM on each computer that it only runs scheduled backup for the intended backup sets 
only. If this is not setup properly, scheduled backup job of the same backup set from different computers will 
both be started. This will result in lots of checksum errors and files being deleted on the backup server. 

To allow multiple computers to be backed up under a single backup account, you are required to do the following 
for each computer  that has installed G-OBM under the same backup account: 

i. Logon to one of the computers that has G-OBM installed under the same backup account. 

ii. Open G-OBM and select a backup set that is not intended to run on this computer from the left 
panel. 

iii. Make sure that the [Run scheduled backup on this computer] checkbox on the right panel is not 
checked. 

iv. Repeat the previous step for the rest of the backup sets that are not intended to run on this 
computer. 

v. Repeat steps ii to iv for each computer that has G-OBM installed under the same backup account. 

IMPORTANT  If you create a new backup set or want to backup another computer using the same backup 
account at a later date (this implies that you need to create an additional backup set under this backup account 
for the new computer), please make sure to repeat the procedure above (i.e. uncheck the [Run scheduled backup 
on this computer] checkbox for the added backup set) for each computer. 
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6 Backing Up Files 

This chapter describes how files are backed up by G-OBM to the backup server 

6.1 How files are backed up 

The diagram below describes how G-OBM backup your files. 

User Directory

Backup Operations:

1.  Collect all files which are new or have

     been updated since last backup

2.  Each of these files is zipped,

     encrypted and securely backed up

     to Online Backup Server through

     Secure Socket Layer (SSL)

Userôs Computer Backup Server

Online Backup Manager can be configured

to start automatically every night. All user

files created/updated during the day will

then be backed up to the backup server on the

same night without any user intervention.

All users' files are encrypted by a

world's first class 128-bit encryption

algorithm with a user defined encrypting

key. File content is meaningless to

everyone except the user.

Backup Directory

 

Run backup at schedu led time automatically  

Once you set your backup scheduled, a backup job will be started automatically to perform backup operation for 
you at your absence. You can have backup running at your scheduled time as often as you want (e.g. twice a day 
or hourly during office hour) without requiring doing any extra work. 

Incremental Backup  

Unchanged files are already backed up to server and need not to be backed up again. G-OBM will pick the new or 
updated files from your backup set files and upload only these files to the server. It significantly reduces the time 
required to perform the backup operation since most users update less than 5% of their total data each day. 

Compress and encrypt data automatically  

Data are compressed and encrypted before they are uploaded to the server. Not only does it reduce the storage 
space to keep you backup files, it also ensures the privacy of your data. 

File Retention Policy  

The built-in file retention policy allows you to access multiple versions of the same file or even deleted files from 
your backup set. Backup files are put into a retention area before they are removed from the server. If you want 
to get back a deleted file (or you want to get back the previous versions of an updated files) within the retention 
period, these files will always be available in the retention area. This feature is particularly useful when you have 
accidentally deleted a file or incorrectly updated a file within the file retention period (file retention period is user 
customizable).  
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6.2 Backup files directly to the backup server 

You can backup your data to Gigasoft Offsite Backup Server by following instructions below. 

vi. Open G-OBM 

vii. Right click G-OBM icon available in the system tray and choose [Open] 

a. Create a backup set 

b. From the Menu, Choose [Backup Set] -> [New] -> [File Backup Set] 
 

 

c. Enter a name for your backup set 
 

 

d. Select the files/directories you want to backup 
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e. Set the backup schedule (Note: You can have more than one schedule in a backup set) 
 

 

f. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
(Hint: For the sake of simplicity, just select the [Default] radio button (your encrypting key 
is set to be the same as your backup account password) 
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viii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) on the toolbar 

b. Select [Off-site Backup Server] to start backing up your files to Gigasoft Offsite Backup 
Server. 
 

 

Note:  
1. You can have more than one backup set in a backup account. 
2. Please write the encrypting key down on paper and keep it in a safe place. If you lose your encrypting key, 

you will not be able to restore your backup files. 

 

6.3 Backup files to removable hard disk (seed loading) 

If you have a lot of data (e.g. 300GB) to backup to the backup server, it would take a considerable amount of 
time to perform the first full backup through the Internet. If you run into this problem, you can use the Seed 
Loading Utility to backup your backup set to local hard disk (instead of directly to the backup server) and then 
transport the backup data, using removable hard disk, to the offsite backup server. The administrator can then 
load all your backup files from your removable hard disk into your backup account. This could then save you days 
(even weeks) of performing your first full backup. Since subsequent backup will be incremental backup (only new 
or updated files will be uploaded to the server) you should have no problems uploading your backup data 
afterwards.  

To perform seeding loading, please do the following: 

i. Open G-OBM from the System Tray (see previous sections for details) 

ii. Setup your backup set (see previous sections for details) 
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iii. Select the backup set you want to run on the left panel and press the [Start Backup] button (►) 

on the toolbar 

iv. Select [Local Hard Disk (Seed Load Utility)] to start backing up your files to local hard disk and 
press the [OK] button 
 

 

v. Enter a directory where you want all backup files to be stored in the [Destination Directory] field 
and press the [Start] button.  
 
Please make sure you have enough free space in the directory specified. If you are going to 
transport a removable hard disk to the offsite backup server, please enter a directory under your 
removable hard disk here. 
 

 

vi. You should get the message ñBackup Completed Successfullyò as shown below after all backup 
files are spooled to the directory you specified.  
 

 

vii. Transport the data specified in the [Destination Directory] field to the offsite backup server 
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7 Restoring Files 

This chapter describes different ways files can be restored from to the backup server 

It is very important to write down your encrypting key on paper and keep it in a safe 
place because there will be no way to restore your backup files if you lose your 
encrypting key.  

 

7.1 Restore backup files directly from backup server 

You can use either G-OBM or the web restorer to restore backup files from the backup server. 

Using G- OBM  

You can restore your data from the backup server by following instructions below. 

i. Open G-OBM from the System Tray (see previous sections for details) 

ii.   Select the [Restore] tab at the bottom part of G-OBM  

iii. Select the backup set from which you would like files to be restored from the left panel 

iv. Select the snapshot of your backup files that you would like to restore from the backup server by 
using [Show files after Job] drop down list 

v. Select the files that you would like to restore and press the [Restore Files] button on the toolbar 

vi. Use the [Browse] button to select the directory to where you want files to be restored (or simply 
select [Original location] to restore files to their original path) 

vii. Files will be restored automatically as shown below (a file wonôt be downloaded from the backup 
server again if an identical file exists on local path already) 

 

7.2 Restore backup files from removable hard disk 

If you want to restore lots of backup files from the backup server and you find it too slow to restore all your 
backup files from the backup server through the internet. You can ask your backup services provider to send you 
all your backup files in removable hard disk (or CD/DVD). However, all backup files stored on backup server are 
in encrypted format. You need to decrypt them back to their original format before you can use them. To decrypt 
your backup files from removable media, please do the followings: 

i. Open G-OBM from the System Tray  

ii. Select the [Tools] -> [Decrypt Files Wizard] from the menu 

iii. Use the [Browse] button to locate the ñfilesò directory (provided by your backup provider in 
removable hard disk or DVD) which contains the backup files that you want to decrypt  

iv. If you have more than one backup set under the ñfilesò directory, select the [Backup Set] which 
contains the backup files that you want to decrypt  

v. Select the snapshot of your backup files that you would like to restore from the removable media 
by using [Show files after Job] drop down list 

vi. If you want to see all the different versions of all files (shown as gray below), just choose the 
[Show all files] radio button on the [Decrypt Files Wizard] dialog.  
 
Files, which are shown in gray below (e.g. AIX_logo.JPG) are being stored in the retention area 
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on the removable media (but you can still restore these files). 

vii. Enter the directory to which you want the backup files to be restored to in the [Decrypt files to] 
section and enter the [Decrypting Key] (the same as the encrypting key of this backup set) 

Press the [Start] button 
 

7.3 IP addresses Restriction for Online Restore 

Online file restore operation can be restricted by IP addresses. You can ask your backup service provider to 
restrict online file restoration for your backup sets by IP addresses to only allow people from authorized IP 
addresses to restore files from the backup server.  

Users are not allowed to update the [Online Restore IP restriction] directly. Please ask your backup services 
provider to do the changes for you. 
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8 In-File Delta Technology 

The chapter describes what in-file delta technology is and how in-file delta can be used to backup large database 
files (e.g. a 10GB Outlook.pst file) without uploading the whole database file everyday. 

8.1 Overview 

In-file delta technology is an advanced data block matching algorithm which has the intelligence to pick up 
changes (delta) of file content between two files. Using this algorithm, daily backing up of large files (e.g. a 10GB 
Outlook.pst file) over low-speed internet connection is made possible because it requires only the changes of 
information (should be marginal) since the last backup to be sent over a low-speed internet connection to 
complete the backup of a large file (here we assume that the full backup of the file has been saved on the backup 
server already).  

This is what will happen in the backup of a 10GB Outlook.pst file when it is backed up by G-OBM with in-file delta 
technology. 

i. The whole files (10GB), along with its checksum file, are backed up to the backup server. This can 
be done directly through the internet or indirectly using the seed loading utility on a removable 
hard disk. 

ii. When backup runs again later (normally the next day), G-OBM will download a checksum listing 
of all data blocks of the full backup file (or last incremental backup file) from the backup server 
and use it to pick up all changes that have been made to the current Outlook.pst file. 

iii. Changes detected are then saved in a delta file which is uploaded to the backup server. A new 
checksum file is generated and is also uploaded. (This delta file is assumed to be small because 
the content of PST files doesnôt change a lot during daily usage)  

iv. Subsequent backups of this 10GB Outlook.pst file will go through step ii and step iii again. As 
explained, only a small delta file and checksum file will be uploaded to the backup server. 

v. With in-file delta technology, daily backing up of large file over low-speed internet connection is 
now possible 

Incremental in - file delta type  

Incremental Delta will facilitate ease of backup. The delta is generated by comparing with the latest uploaded full 
or delta file. The delta file generated is the smallest possible and uses the least bandwidth during backup. For 
restoration, the full file and all delta files up to the required point-in-time is required to restore the file to a 
specific point-in-time. 

Example: If you are adding around 100MB changes to a 10G Outlook.pst everyday. 

After the first full backup job, G-OBM will continue to generate and upload delta files instead of uploading the full 
file until either one of the following two rules are true: 

a) Number of deltas generated since the last full backup is greater than the [Number of Delta] setting. 

b) The delta ratio (the ratio of the delta file size against the full file size) is greater than the [Delta Ratio] 
setting 

Using incremental delta, the delta generated by comparing the current file with the latest uploaded full or delta 
file is around 100MB. 

Since the delta file size is around 100MB daily, the delta ratio (around 1%) will not trigger a full file upload. 
Instead G-OBM will continue to generate and upload delta files until day 102 (assuming the full file was uploaded 
on day 1) when the number of deltas generated exceeds the [Number of Delta] setting and triggers the upload of 
the full Outlook.pst file. You can disable the [Number of Delta] and [Delta Ratio] if you donôt want to upload the 
full file. 

All delta files are generated with respect to changes made since the last incremental or full backup. This means 
that the last full backup file and ALL  incremental delta backup files are required to restore the latest snapshot of 
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a backup file.  

Differential in - file delta type  

Differential Delta will facilitate ease of restore. The delta is generated by comparing with the latest uploaded full 
file. The delta file generated grows daily and uses more bandwidth during backup. For restoration, the full file and 
a single delta file is required to restore the file to a specific point-in-time. 

Example: If you are adding around 100MB changes to a 10G Outlook.pst everyday. 

After the first full backup job, G-OBM will continue to generate and upload delta files instead of uploading the full 
file until either one of the following two rules are true: 

c) Number of deltas generated since the last full backup is greater than the [Number of Delta] setting. 

d) The delta ratio (the ratio of the delta file size against the full file size) is greater than the [Delta Ratio] 
setting 

Using differential delta, the delta generated by comparing the current file with the latest uploaded full file is 
around 100MB for the 1st delta, 200MB for the 2nd delta, 300MB for the 3rd delta and so on. 

Since the delta file grows by 100MB daily, the delta ratio for day 52 (delta file size is approximately 51x100= 
5.1GB, assuming the full file was uploaded on day 1) being over 50% exceeds the [Delta Ratio] setting and 
triggers the upload of the full Outlook.pst file. You can disable the [Number of Delta] and [Delta Ratio] if you 
donôt want to upload the full file. 

All delta files are generated with respect to changes made since the last full backup file (i.e. differential backup). 
This means that only last full backup file and the last delta file are required to restore the latest snapshot of a 
backup file. This means that other intermediate delta files are only required if you want to restore other 
snapshots of a backup file. 

Differential in-file delta backup has the benefits that a corrupted delta file would only make one particular version 
of a backup file non-recoverable and all other backups created by other delta files of the same file would still be 
intact. 
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8.2 Block Size 

The block size defines the size of data block being used to detect the changes between the last full or delta 
backup file and the file sitting on the local computer right now. In general, the smaller the block size, the more 
likely a matched data block can be found between the last backup file and the file on local computer. It, therefore, 
produces a smaller delta file but it would require more processing power to detect these changes. On the other 
hand, in-file delta backup running with larger block size will run faster but this will generally produce a larger 
delta file. 

In most case, the default setting [Auto] will choose the optimal block size for each file (depending on the size of 
the file) for you. 

8.3 Minimum File Size 

The [Minimum File Size] setting defines the smallest file size a file must have before the use and application of in-
file delta backup technology.  

If the size of a file that is being backed up is smaller than the [Minimum File Size] setting, in-file delta backup 
technology wonôt be applied to this file and the whole file, instead of just the delta file, will be uploaded to the 
backup server. It is not necessary to perform in-file delta backup on small files because backing up the whole file 
doesnôt take too long anyway. Backing up the whole file instead reduces the time required to restore a backup file. 

8.4 Uploading full file again 

No. of Delta  

The [No. of delta] setting defines the maximum number of delta files from the same full backup file to be 
generated and backed up to the backup server before a full backup (the whole file) of this file is uploaded to the 
backup server instead.  

For example, if you have created 100 delta files from the full backup file already and the [No. of delta] setting is 
set to 100, the next backup will upload a full backup file (the whole file) instead of just the delta file. However, if 
the [No. of delta] rule is disabled, it will keep generating delta files and uploading these delta files to the backup 
server until the other delta rule forces a full backup (i.e. delta ratio exceeded). This setting is here to make sure 
that there will always be a full backup file after a certain number of delta files have been generated. 

Delta Ratio  

The [Delta Ratio] setting is defined to be the size of a delta file divided by the size of its full backup file (i.e. the 
percentage of changes detected between the last full backup file and the current file).  

If the delta ratio calculated from the size of the generated delta file and the size of the full backup file is greater 
than the [Delta Ratio] setting, the whole file, instead of just the delta file, will be backed up to the backup server. 
It is done this way because the difference between backing up the whole file and the delta file is not significant 
and it is better to upload the whole file instead to reduce the time required to restore the file. 

The default setting of [Delta Ratio] is 50%. This means that if a file changes by more than 50%, the whole file, 
instead of just the delta file, will be backed up and uploaded to the backup server.  

8.5 Advanced In-file delta type 

The [In-file delta] -> [Advanced] setting allows users to override default in-file delta type when on a certain 
number of days (e.g. all Sundays or the 1st day of each month). This is useful if you want all in-file delta backups 
to be incremental but you want to do a differential in-file delta backup on Saturdays as well as the full file 
backups on the 1st day of every month. If you want to do this, simply configure [In-file delta] -> [Advanced] -> 
[Advanced In-file Delta Type Setting] to what is shown below.  
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With this setting, all backup Jobs on Saturdays will be differential in-file delta backups, backups for the 1st day of 
each month will run a full backup. This ensures that all backup files will be backed up in full at a regular interval. 
One benefit of this is that restore time will run faster because of less delta merging. Another benefit is that the 
risk of a corrupted incremental delta file resulting in data loss is much lower because a full backup is always 
available periodically. 
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9 Backup/Restore Oracle 8i/9i 

This chapter will describe in details how G-OBM backup your Oracle 8i/9i and how you can restore an Oracle 8i/9i 
database using the backup files.  

9.1 Requirements 

i. G-OBM must be installed onto the computer that can connect to your Oracle 8i/9i server using 
TCP/IP protocol. 

ii. Data from Oracle 8i/9i database will be backed up to a temporary directory before they are sent to 
the Offsite Backup Server. Please make sure you have sufficient space on your computer to store 
these data when you run the backup job. 

iii. Database must be in archived log mode 
 
To switch to archived log mode and enable automatic log archiving, please do the following: 

a. Set the parameters below in the PFILE to enable automatic archiving 
 
log_archive_dest = [directory where archived logs will be stored] 
log_archive_format = ARCH%S.LOG 
log_archive_start = TRUE 

b. Switch to archived log mode 
 
SVRMGRL> connect internal; 
SVRMGRL> startup mount; 
SVRMGRL> alter database archivelog; 
SVRMGRL> alter database open; 

c. Enable Oracle JVM for Oracle 8i/9i, please do the following: 

1. Please make sure shared pool size is larger than 50MB and java pool size is larger than 
20MB in the PFILE. For example: 
 
java_pool_size = 20971520 
shared_pool_size = 52428800 

2. Run the scripts below  
 
For Oracle 8i 
SVRMGRL> connect internal 
SVRMGRL> @?/javavm/install/initjvm.sql; 
SVRMGRL> @?/rdbms/admin/catalog.sql; 
SVRMGRL> @?/rdbms/admin/catproc.sql; 
SVRMGRL> @?/javavm/install/initdbj.sql; 
 
For Oracle 9i 
SQL> connect sys/change_on_install as sysdba 
SQL> @?/javavm/install/initjvm.sql; 
SQL> @?/xdk/admin/initxml.sql; 
SQL> @?/xdk/admin/xmlja.sql; 
SQL> @?/rdbms/admin/catjava.sql; 
 
For Oracle 10g 
Oracle JVM is enabled by default. No additional steps required.  

iv. JAVASYSPRIV role is granted to system account 
 
You can grant this role to system account by executing: 
 
SQL> grant JAVASYSPRIV to system; 
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9.2 Overview 

G-OBM will backup your Oracle database by taking the following steps. 

i. Connect to the Oracle database using SQL*NET over TCP/IP 

ii. Run all Pre-Commands of this backup set 

iii. If the backup type to run is [Database Backup type], 

a. all data files in each of the tablespace(s) selected are copied to the temporary directory 
specified by this backup set 

b. if there are temporary files in the database, the script to re-create the temporary files are 
generated to a file located in the temporary directory specified by this backup set 

c. all non-default initialization parameters will be spooled to an initializing file located in the 
temporary directory specified by this backup set 

d. all control files will be copied to the temporary directory specified by this backup set 

e. all archived log files will be copied to the temporary directory specified by this backup set 

iv. If the backup type to run is [Archived Log Backup type], 

a. all archived log files will be copied to the temporary directory specified by this backup set  

v. Run all Post-Commands of this backup set 

vi. Upload all files copied to the temporary directory to the Offsite Backup Server 

vii. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 

Note: 
If your Oracle database is running on Windows, please install G-OBM onto the company running the Oracle 
database if G-OBM is to backup this Oracle database. This would shorten the time required to backup the Oracle 
database. 
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9.3 How to backup an Oracle Database 

Please follow the instructions below to backup your Oracle database to the Gigasoft Offsite Backup Server.  

i. Install G-OBM onto your computer 

ii. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  
 

 
 

iii. Create a backup set  

a. From the Menu, Choose [Backup Set] -> [New] -> [Oracle Database Backup Set]  
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b. Enter a name for your backup set 
 

 

c. Enter the system password, the Oracle Database Server Host Name, TNS Port and SID 

d. Select the tablespace(s) you want to backup 
 

 

e. Enter a temporary location to store the database file(s) before they are sent to an Offsite 
Backup Server 

f. Set the backup schedule for database backup and archived log backup 
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Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day transaction log 
backup by adding more than one daily transaction log backup schedule to your backup set. 

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters. 

iv. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select the backup type (e.g. Database Backup, Archived Log Backup) you would like to 
perform 
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c. Select [Off-site Backup Server] to start backing up your files to the Offsite Backup Server.  
 

 
 

9.4 How to restore an Oracle Database 

Please follow the instructions below to restore your Oracle 8i/9i databases from the Gigasoft Offsite Backup 
Server.  

i. Download the backup files from the Offsite Backup Server 
 
Please refer to the [Quick Start - Backup File] section for information on how to download backup 
files from the Offsite Backup Server. 

ii. Put all data files back to their original locations 

iii. Control files, data files and archived logs are stored on the Offsite Backup Server along with their 
full path information. You just need to put all these files back to their original locations when 
performing a database restore. 

iv. Put the PFILE back to its default location 
 
Oracle 8i: $ORACLE_HOME/dbs/init<SID>.ora 
Oracle 9i: $ORACLE_HOME/admin/<SID>/pfile/init.ora 

v. Restore Database 
 
(if Oracle 8i) Use Server Manager to restore you database by doing the following:  

a. Run Oracle Server Manager (svrmgrl) 

b. Connect to the target database 

c. Startup mount 

d. Reapply all transactions from the archived log files 

e. Open database 

Oracle 8i Example: 
$ svrmgrl  

 

SVRMGRL> connect internal  

 

SVRMGR> startup mount;  

ORACLE i nstance started.  

Total System Global Area   95874448 bytes  

Fixed Size    64912 bytes  

Variable Size    52744192 bytes  

Database Buffers    40960000 bytes  

Redo Buffers    2105344 bytes  

Database mounted.  

 

SVRMGRL> recover database using backup controlfile  

ORA- 00279 : change 419671 generated at 06/14/03 02:51:49 needed for thread 1  

ORA- 00289: suggestion : /data/ora815/vin/archive/ARCH0000000225.LOG  

ORA- 00280: change 419671 for thread 1 is in sequence #225  

ORA- 00278: log file '/data/ora815/vin/archive/ARCH0000000224.LO G' no longer needed for this 

recovery  

Specify log: {<RET>=suggested | filename | AUTO | CANCEL}  

AUTO 

Log applied.  

. . . . . . . . . . .  

ORA- 00279: change 547222 generated at 06/18/03 19:58:26 needed for thread 1  

ORA- 00289: suggestion : /data/ora815/vin/ar chive/ARCH0000000384.LOG  

ORA- 00280: change 547222 for thread 1 is in sequence #384  
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ORA- 00278: log file '/data/ora815/vin/archive/ARCH0000000383.LOG' no longer needed for this 

recovery  

ORA- 00308: cannot open archived log '/data/ora815/vin/archive/ARCH000000 0384.LOG'  

ORA- 27037: unable to obtain file status  

Linux Error: 2: No such file or directory  

Additional information: 3  

 

SVRMGR> recover database using backup controlfile until cancel  

ORA- 00279: change 547222 generated at 06/18/03 19:58:26 needed for thread 1 

ORA- 00289: suggestion : /data/ora815/vin/archive/ARCH0000000384.LOG  

ORA- 00280: change 547222 for thread 1 is in sequence #384  

Specify log: {<RET>=suggested | filename | AUTO | CANCEL}  

CANCEL 

Media recovery cancelled.  

SVRMGR> alter database open resetlogs ;  

Statement processed.  

 

(if Oracle 9i) Use Recovery Manager to restore you database by doing the following:  

a. Run Oracle Server Manager (rman) 

b. Connect to the target database 

c. Startup mount 

d. Reapply all transactions from the archived log files to the last sequence 

e. Open database 

Oracle 9i Example: 
C: \ >rman nocatalog  

 

Recovery Manager: Release 9.2.0.1.0 -  Production  

 

Copyright (c) 1995, 2002, Oracle Corporation.  All rights reserved.  

 

RMAN> connect target  

 

connected to target database (not started)  

 

RMAN> start up mount  

 

connected to target database (not started)  

Oracle instance started  

database mounted  

 

Total System Global Area     269556596 bytes  

 

Fixed Size                      453492 bytes  

Variable Size                243269632 bytes  

Database Buffers              25165824 bytes  

Redo Buffers                    667648 bytes  

 

RMAN> recover database until sequence=63 thread=1;  

 

Starting recover at 24 - JUN- 03 

allocated channel: ORA_DISK_1  

channel ORA_DISK_1: sid=11 devtype=DISK  

 

starting media recovery  

 

archive log thread 1 sequence 56 is already on disk as file 

C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_56.DBF  

archive log filename=C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_56.DBF thread=1 sequence=56  

archive log filename=C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_57.DBF thread=1 sequence=57  

archive  log filename=C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_58.DBF thread=1 sequence=58  

archive log filename=C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_59.DBF thread=1 sequence=59  

archive log filename=C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_60.DBF thread=1 sequence=60  

archive log filename =C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_61.DBF thread=1 sequence=61  

archive log filename=C: \ ORACLE\ ORADATA\ VIN \ ARCHIVE\ 1_62.DBF thread=1 sequence=62  

media recovery complete  

Finished recover at 24 - JUN- 03 

 

RMAN> alter database open resetlogs;  

 

database opened  
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10 Backup/Restore Microsoft SQL Server 7.0 / 2000 

This chapter will describe in details how to use G-OBM to backup your Microsoft SQL Server 7.0 / 2000 server 
and how you can restore your Microsoft SQL Server 7.0 / 2000 server from the backup files.  

10.1 Requirements 

i. G-OBM must be installed onto the computer running Microsoft SQL Server. 

ii. Data from Microsoft SQL Server will be backed up to a temporary directory before they are sent 
to Offsite Backup Server. Please make sure you have sufficient space on your computer to store 
these data when you run the backup job.  

10.2 Overview 

G-OBM will backup your Microsoft SQL Server database(s) by taking the following steps: 

i. Before running any backup activities, G-OBM will run all Pre-Commands of the backup set. 

ii. For each database that is to be backed up, G-OBM will issue a database / transaction log backup 
command to Microsoft SQL Server to backup each database to a Microsoft SQL Server database 
backup file (*.bak file) and save it in the temporary directory you specified. 

iii. After all *.bak files have been spooled to the temporary directories, G-OBM will run all Post-
Commands of the backup set. 

iv. Upload all files copied to the temporary directory to the Offsite Backup Server. 

v. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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10.3 How to backup Microsoft SQL Server database(s) 

Please follow the instructions below to backup your Microsoft SQL Server databases using G-OBM.  

i. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  
 

 
 

ii. Create a backup set  

a. From the Menu, Choose [Backup Set] -> [New] -> [MS SQL Server Backup Set] 
 

 
 

b. Enter a name for your backup set 
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c. Enter the Microsoft SQL Server administrator username and password 

d. Select the database(s) you want to backup 
 

 

e. Enter a temporary location to store the backup files before they are sent to the Offsite 
Backup Server 

f. Set the backup schedule for full database backup and transaction log backup 
 

 
 
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day 
transaction log backup by adding more than one daily transaction log backup schedule to 
your backup set) 

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 
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iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select the backup type (e.g. Complete, Differential, Transaction Log) you would like to 
perform 
 

 

c. Select [Off-site Backup Server] to start backing up your files to the Offsite Backup Server. 
 

 

10.4 How to restore Microsoft SQL Server database(s) 

Please follow the instructions below to restore your Microsoft SQL Server databases from Gigasoft Offsite Backup 
Server.  

i. Download the backup files (.bak) from the Offsite Backup Server 
 
Please refer to the [Quick Start - Backup File] section for information on how to download backup 
files from the Offsite Backup Server. 

ii. Open Microsoft SQL Enterprise Manager  
 
You can open Microsoft SQL Enterprise Manager from [Start Menu] -> [Program] -> [Microsoft 
SQL Server] -> [Enterprise Manager] 

iii. (Optional) Restore ñmasterò database  

You need to restore ñmasterò database if you: 
a. are rebuilding all your databases from scratch 

b. have changing any server-wide or database configuration options 
c. have added logins or other login security-related operations.  
d. have created or removed logical backup devices. 
e. have configured the server for distributed queries and remote procedure calls, such as 

adding linked servers or remote logins. 
 
You do not need to restore your master database if you just want to restore a user database. For 
more information on Microsoft SQL Server ñmasterò database, please visit 
http://www.microsoft.com/sql/.  
 
To restore ñmasterò database, please do the following: 

 
a. Start Microsoft SQL Server in ñSingle User Modeò 

1. Right click your Microsoft SQL Server and select [Properties] 
 

http://www.microsoft.com/sql/
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2. Press the [Startup Parameters] button 
 

 
 

3. Add a ñ-mò parameter to the [Startup Parameters] 
 

 
 

4. Restart Microsoft SQL Server 
 
From [Enterprise Manager], right click your Microsoft SQL Server and select [Stop] and 
then [Start]. 
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b. Restore ñmasterò database 

1. From [Enterprise Manager] -> [Tools] -> [Restore Database] 
 

 
 

2. Select [master] in the [Restore as database] drop down list  
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3. Select the [From device] radio button. 

4. Press the [Select Devices] button. 
 

 
 

5. From the [Choose Restore Devices], press the [Add] button. 
  

 

6. From the [Choose Restore Destination] panel, press the [é] button to choose your 
master backup (*.bak) from your backup files 
 

 
 

7. Press the [OK] button, to start restoring the ñmasterò database. 

c. Restart Microsoft SQL Server in ñNormal Modeò 

1. Remove ñ-mò parameter from the [Startup Parameters] as in previous step 

2. Restart your Microsoft SQL Server as in previous step 

iv. (Optional) Restore ñmodelò, ñmsdbò and ñdistributionò database 
 
You need to restore ñmodelò database if you have changed the database template of your SQL 
Server.  
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You need to restore ñmsdbò database if you have changed the scheduling information or you want 
to restore the backup and restore history of your databases. 
 
You need to restore ñdistributionò database if you are running the replication components of SQL 
Server. 
 
You do not need to restore these databases if you just want to restore a user database. For more 
information on Microsoft SQL Server ñmodelò, ñmsdbò and ñdistributionò database, please visit 
http://www.microsoft.com/sql/.  
 
You need to restore each of these databases one by one. To restore any of these databases, 
please do the following: 

a. From [Enterprise Manager] -> [Tools] -> [Restore Database] 

b. Select the database to be restored in the [Restore as database] drop down list  

c. Select the [From device] radio button. 

d. Press the [Select Devices] button 

e. Press the [é] button to choose your backup files (*.bak) for the database to be restored 

f. Press the [OK] button 

v. Restore user database(s)  
 
For each of the database you would like to restore,  

a. From [Enterprise Manager] -> [Tools] -> [Restore Database] 

b. Select the database to be restored in the [Restore as database] drop down list  

c. Select the [Database] radio button. 
 

 

d. From the [Show backups of database] drop down list, select the database to be restored 

e. From the [First backup to restore] drop down list, select the snapshot of the database you 
would like to restore to.  
 
You can restore your database to the snapshot of your database at any point of the time 
between the time you did your full backup and the time you did your last subsequent backup.  

f. Change the [Restore From] entry  
 
If you backup files (*.bak) are not in the default directory, you need to update the full path 

http://www.microsoft.com/sql/
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to your backup files by pressing the [Properties] button. 

g. Press the [OK] button 

vi. All database(s) restored successfully 
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11 Backup/Restore Lotus Domino / Notes 

This chapter will describe in details how to use G-OBM to backup your Lotus Domino server / Notes client 5 / 6 / 
6.5 and how you can restore your Lotus Domino server / Notes client 5 / 6 / 6.5 from the backup files.  

11.1 Requirements 

i. G-OBM must be installed onto the computer running Lotus Domino server / Notes client. 

ii. Data from Lotus Domino server / Notes client will be backed up to a temporary directory before 
they are sent to the Offsite Backup Server. Please make sure you have sufficient disk space on 
your computer to store these data when you run the backup job. 

iii. Lotus Domino server must runs with archive transaction logging enabled 
 
To set up transaction logging in archive style, please do the following: 

a. Ensure that all databases to be logged reside in the Domino data directory, either at the root 
or in subdirectories. 

b. From the Domino Administrator, click the Configuration tab. 

a. In the "Use Directory on" field, choose the server's Domino Directory. 

b. Click Server Configuration, and then click Current Server Document. 

c. Click the Transactional Logging tab. 

d. Complete these fields, and then save the document. 

Field Enter 

Transactional Logging Choose Enabled. The default is Disabled. 

Log path Path name location of the transaction log. 
The default path name is \LOGDIR in the Domino 
data directory, although it is strongly recommended 
to store the log on a separate, mirrored device, 
such as a RAID (Redundant Array of Independent 
Disks) level 0 or 1 device with a dedicated 
controller. 
The separate device should have at least 1GB of 
disk space for the transaction log. If you are using 
the device solely for storing the transaction log, set 
the "Use all available space on log device" field to 
Yes. 

Logging style Choose Archive. The default is Circular. 

Maximum log space The maximum size, in MB, for the transaction log. 
Default is 192MB. Maximum is 4096MB (4GB). 
Domino formats at least 3 and up to 64 log files, 
depending on the maximum log space you allocate. 

Use all available 
space on log device 

Choose one: 
· Yes to use all available space on the device for 

the transaction log. This is recommended if you 
use a separate device dedicated to storing the 
log. If you choose Yes, you donôt need to enter 
a value in the "Maximum log space" field. 

· No to use the default or specified value in the 
"Maximum log space" field. 

Automatic fixup of 
corrupt databases 

Choose one: 
· Enabled (default). If a database is corrupt and 

Domino cannot use the transaction log to 
recover it, Domino runs the Fixup task, assigns 
a new DBIID, and notifies the administrator that 
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a new database backup is required. 
· Disabled. Domino does not run the Fixup task 

automatically and notifies the administrator to 
run the Fixup task with the -J parameter on 
corrupt logged databases. 

Runtime / Restart 
performance 

This field controls how often Domino records a 
recovery checkpoint in the transaction log, which 
affects server performance. 
To record a recovery checkpoint, Domino evaluates 
each active logged database to determine how 
many transactions would be necessary to recover 
each database after a system failure. When Domino 
completes this evaluation, it: 
· Creates a recovery checkpoint record in the 

transaction log, listing each open database and 
the starting point transaction needed for 
recovery 

· Forces database changes to be saved to disk if 
they have not been saved already 

Choose one: 
· Standard (default and recommended). 

Checkpoints occur regularly. 
· Favor runtime. Domino records fewer 

checkpoints, which requires fewer system 
resources and improves server run time 
performance. 

· Favor restart recovery time. Domino records 
more checkpoints, which improves restart 
recovery time because fewer transactions are 
required for recovery. 

 
Notes: 
You can only run transaction log backup if you have transaction logging enabled and you are 
using archive mode. This command does not apply if you have transaction logging enabled not 
in archive mode or if transaction logging is not enabled at all. If you try to issue it, you will 
receive an error message. 

11.2 Overview 

G-OBM will backup your Lotus Domino server / Notes client by taking the following steps: 

i. Run all Pre-Commands of this backup set 

ii. If the backup type to run is [Database Backup type], 

a. all file(s) / database(s) selected are copied to the temporary directory specified by this 
backup set 

b. the notes.ini file, if selected, will be copied to the temporary directory 

c. only filled log extents will be copied to the temporary directory, and the Domino server is 
notified of their availability for reuse (for Domino server only) 

iii. (for Domino server only) If the backup type to run is [Transaction Log Backup type], 

a. only filled log extents will be copied to the temporary directory, and the Domino server is 
notified of their availability for reuse 

iv. Run all Post-Commands of this backup set 

v. Upload all files copied to the temporary directory to the Offsite Backup Server  

vi. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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11.3 How to backup Lotus Domino / Notes database(s) / file(s) on 

Windows 

Please follow the instructions below to backup your Lotus Domino server / Notes client databases / files using G-
OBM. 

i. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  

 

 

ii. Create a backup set 

a. From the Menu, Choose [Backup Set] -> [New] -> [Lotus Backup Set] 
 

 
 

b. Enter a name for your backup set 
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c. Select the Backup Set Type (Lotus Domino Server Backup / Lotus Notes Client Backup) 

d. Select the database(s) / file(s) you want to backup 
 

 

e. Enter a temporary location to store the backup files before they are sent to the Offsite 
Backup Server 

f. Set the backup schedule for Database Backup 
 

 

g. Set the backup schedule for Transaction Log Backup (for Domino server only) 
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day 
transaction log backup by adding more than one daily transaction log backup schedule to 
your backup set) 

h. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
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(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select the backup type (e.g. Database, Transaction Log) you would like to perform (for 
Domino server only) 
 

 

c. Select [Off-site Backup Server] to start backing up your files to the Offsite Backup Server. 
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11.4 How to restore Lotus Domino / Notes database(s) / file(s) on 

Windows 

Please follow the instructions below to restore Lotus Domino server / Notes client database(s) / file(s) from the 
Gigasoft Offsite Backup Server.  

i. Install Lotus Domino server / Notes client back to its original folder (if required) 

ii. Install G-OBM 
 
Please refer to the [Installation] section for information on how to install G-OBM onto your 
computer. 

iii. Shutdown Lotus Domino Server 

iv. If you want to perform a full domino restore (restore all databases and files): 

a. Download the backup files to be restored from the Offsite Backup Server and save them 
back to its original location. It includes notes.ini, all backup files from the lotus domino data 
directory and all archived transaction logs 

b. Modify the ñDominoRecover.batò located under the bin directory of the OBM installation to 
reflect your setup. You need to specify the lotus executable directory. 

For example change the PROGRAM_DIR to: 
               PROGRAM_DIR=C:\Lotus\Domino 

c. Run ñDominoRecover.batò and press óYô to continue. 
For example: C:\program files\obm\bin\DominoRecover.bat 

 
This will run media recovery for all databases (*.nsf and mail.box) found under the Lotus 
data directory (e.g. C:\Lotus\Domino\Data). You should see something similar to the screen 
below. 

Media Recovery Example: 
 

C: \ program files \ obm\ bin >Domino Recover.bat  

Media Recovery Utility for Lotus Domino 5.0 or above  

 

Please make sure that you have done the following:  

1. Reinstall Lotus Domino on this computer in the same directory  

2. Restore Notes.ini to the Lotus Domino installation directory  

   (e.g. C : \ Lotus \ Domino)  

3. Restore Domino Data directory back to the directory defined  

   in Notes.ini (e.g. C: \ Lotus \ Domino \ Data)  

4. Restore all archived transaction logs to the directory defined  

   in Notes.ini (e.g. C: \ Lotus \ Domino \ Data \ logdir)  

 

Continue ? (Y) or (N) y  

Running media recovery ...  

Please wait, creating new transaction logs in directory: C: \ logdir \  

02/12/2003 14:39:19   Recovery Manager: Restart Recovery complete. (0/0  

databases needed full/partial recovery)  

Media Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%  

02/12/2003 14:39:22   Recovery Manager: Media Recovery complete for  

C: \ Lotus \ Domino \ Data \ admin4.nsf, last update applied .  

 

 Backup file C: \ Lotus \ Domino \ Data \ admin4.nsf recovered.  

 

éééé 

 

Media Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%  

02/12/2003 14:40:57   Recovery Manager: Media Recovery complete for  

C: \ Lotus \ Domino \ Data \ statrep.nsf, last update applied .  

 

 Backup file C: \ Lotus \ Domino \ Data \ statrep.nsf recovered.  

 

C: \ program files \ obm\ bin > 

 

d. All content of all database(s) are now rolled forward to the last committed transaction found 
in the last archived transaction log. 

e. Restart Lotus Domino server 
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v. If you just want to restore a single database: 

a. Download the database file to be restored from the Offsite Backup Server and save them 
back to its original location.  

b. (optional) If you need to perform media recovery on this database, please download all 
archived transaction logs and save them back to its original location 

c. Modify the ñDominoRecover.batò located under the bin directory of the OBM installation to 
reflect your setup. 
 
For example we will recover the ñadmin4.nsfò and have restored the file to 
C:\restore\notesdata, change the tags to: 
               PROGRAM_DIR=C:\Lotus\Domino 
               INPUTFILE=C:\restore\notesdata\admin4.nsf 
               RESTOREDB=C:\Lotus\Domino\Data\admin4.nsf 
               RECDATE=18/01/2007 
               RECTIME=00:02 

d. Run ñDominoRecover.batò. 
 
You should see something similar to the screen below. 

Media Recovery Example: 
 

C: \ program files \ obm>DominoRecover.bat  

Media Recovery Utility for Lotus Domino 5.0 or above  

 

Running media recovery ...  

Restart Analysis (0 MB): 100%  

18/ 01/200 7 14:42:15   Recovery Manager: Restart Recovery complete. (0/0  

databases needed full/partia l recovery)  

Media Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100%  

18/ 01/200 7 14:42:17   Recovery Manager: Media Recovery complete for  

C: \ Lotus \ Domino \ data \ admin4.nsf, last update applied  .  

 

 Backup file C: \ Lotus \ Domino \ data \ admin4.nsf re covered.  

 

 

C: \ Lotus \ Domino>  

 

 

e. All content of the database are now rolled forward to the last committed transaction found in 
the last archived transaction log. 

f. Restart Lotus Domino Server 
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11.5 How to backup Lotus Domino / Notes database(s) / file(s) on 

Linux 

Please make sure that the user running G-OBM have sufficient privileges to read and write to the ñnotesenvò file 
located in the ñbinò subdirectory of where G-OBM is installed. This file is used by G-OBM to store the location of 
the domino/notes application executables. e.g. use chmod to set read, write & execute permissions 

# cd $OBM_HOME/bin 
# chmod 777 notesenv 
 

Please follow the instructions below to backup your Lotus Domino server / Notes client databases / files using G-
OBM. 

i. Open G-OBM by typing the following in a terminal 
 
# cd $OBM_HOME 
# ./bin/BackupManager.sh 
 

ii. Create a backup set 

a. From the Menu, Choose [Backup Set] -> [New] -> [Lotus Backup Set] 
 

 
 

b. Enter a name for your backup set 
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c. Select the location of the ñnote.iniò file. The default path for this will be in the 
/local/notesdata folder. 

d. Select the database(s) / file(s) you want to backup 
 

 

e. Enter a temporary location to store the backup files before they are sent to the Offsite 
Backup Server. Please make sure that the user running G-OBM have sufficient privileges to 
read and write to this location and sufficient space is available. 

f. Set the backup schedule for Database Backup 
 

 

 
 

g. Set the backup schedule for Transaction Log Backup (for Domino server only) 
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day 
transaction log backup by adding more than one daily transaction log backup schedule to 
your backup set) 
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h. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select the backup type (e.g. Database, Transaction Log) you would like to perform (for 
Domino server only) 
 

 

c. Select [Off-site Backup Server] to start backing up your files to the Offsite Backup Server. 
 

 

d. You should get something similar to the screen shot below. 
 



 Gigasoft Holdings Plc 

  

Gigasoft Online Backup 
User Guide 

   

 

Gigasoft Holdings Plc Page 69 of 102 (March 31, 2008) 

 

 

 

11.6 How to restore Lotus Domino / Notes database(s) / file(s) on 

Linux 

Please follow the instructions below to restore Lotus Domino server / Notes client database(s) / file(s) from 
Gigasoft Offsite Backup Server.  

i. Install Lotus Domino server / Notes client back to its original folder (if required) 

ii. Install G-OBM 
 
Please refer to the [Installation] section for information on how to install G-OBM onto your 
computer. 

iii. Shutdown Lotus Domino Server 

iv. If you want to perform a full domino restore (restore all databases and files): 

a. Download the backup files to be restored from the Offsite Backup Server and save them 
back to its original location. It includes notes.ini, all backup files from the lotus domino data 
directory and all archived transaction logs. If you encounter any access problems, please try 
restoring using the ñrootò user. 

b. Make sure that the owner and group permissions of the restored files are the notes user 
 
For example:  # chown –R notes:notes /local/notesdata 

 
This will assign the owner and group to all files and directories within /local/notesdata. 

c. Modify the ñDominoRecover.shò located under the bin directory of the G-OBM installation to 
reflect your setup. You need to specify the data directory and the lotus executable directory. 
 
For example change the DATA_DIR and LOTUS tags to: 
               DATA_DIR=/local/notesdata 
               LOTUS=/opt/ibm/lotus  

d. Make sure the current user is the notes user before running the ñDominoRecover.shò. 

e. Run ñDominoRecover.shò and press óYô to continue. 
 
For example: #./usr/local/obm/bin/DominoRecover.sh 
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This will run media recovery for all databases (*.nsf and mail.box) found under the Lotus 
data directory (e.g. /local/notesdata). You should see something similar to the screen below. 

Media Recovery Example: 
 

bash - 3.00$ cd /usr/local/obm/bin  

bash - 3.00$ ./DominoRecover.sh  

Media Recovery Utility for Lotus Domino 5.0 or above  

 

Please make sure that you have done the following:  

1. Reinstall Lotus Domino on this computer in the same directory  

2. Restore Notes.in i to the Lotus Domino installation directory  

   (e.g. /local/notesdata)  

3. Restore Domino Data directory back to the directory defined  

   in Notes.ini (e.g. /local/notesdata)  

4. Restore all archived transaction logs to the directory defined  

   in Notes.ini  (e.g. /local/notesdata/logdir)  

 

Continue ? (Y) or (N) y  

 

Running media recovery ...  

directory /local/notesdata// already exists  

Please wait, creating new transaction logs in directory: /local/notesdata/logdir/  

02/01/2007 11:38:43 AM  Recovery Manager: Res tart Recovery complete. (0/0 databases 

needed full/partial recovery)  

02/01/2007 11:38:45 AM  Recovery Manager: Assigning new DBIID for 

/local/notesdata/names.nsf (need new backup for media recovery).  

Media Recovery Replay (0 MB): 100%  

02/01/2007 11:38:45 A M  Recovery Manager: Media Recovery complete for 

/local/notesdata/dfc/dfc100.nsf, last update applied .  

 

 Backup file /local/notesdata/dfc/dfc100.nsf recovered.  

Media Recovery Replay (0 MB): 100%  

02/01/2007 11:38:46 AM  Recovery Manager: Media Recovery com plete for 

/local/notesdata/help/decsdoc.nsf, last update applied .  

 

é 

 

 Backup file /local/notesdata/iNotes/help70_iwa_en.nsf recovered.  

Media Recovery Replay (0 MB): 100%  

02/01/2007 11:38:50 AM  Recovery Manager: Media Recovery complete for 

/local/notesda ta/mail/notes.nsf, last update applied .  

 

 Backup file /local/notesdata/mail/notes.nsf recovered.  

bash - 3.00$  

 

 

f. All content of all database(s) are now rolled forward to the last committed transaction found 
in the last archived transaction log. 

g. Restart Lotus Domino server 

 

v. If you just want to restore a single database: 

a. Download the database file to be restored from the Offsite Backup Server and save them 
back to its original location.  

b. (optional) If you need to perform media recovery on this database, please download all 
archived transaction logs and save them back to its original location 

c. Modify the ñDominoRecover.shò located under the bin directory of the G-OBM installation to 
reflect your setup. 
 
For example we will recover the ñadmin4.nsfò and have restored the file to 
/restore/local/notesdata, change the tags to: 
               DATA_DIR=/local/notesdata 
               LOTUS=/opt/ibm/lotus 
               INPUTFILE=/restore/local/notesdata/admin4.nsf 
               RESTOREDB=/local/notesdata/admin4.nsf 
               RECDATE=18/01/2007 
               RECTIME=22:41 

d. Make sure the current user is the notes user before running the ñDominoRecover.shò. 

e. Run ñDominoRecover.shò. 
 
You should see something similar to the screen below. 

Media Recovery Example: 
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bash - 3.0 0$ cd /usr/local/obm/bin  

bash - 3.00$ ./DominoRecover.sh  

Media Recovery Utility for Lotus Domino 5.0 or above  

 

directory /local/notesdata// already exists  

 

 Recovering backup file ...  

 

Restart Analysis (0 MB): 100%  

18/01/2007 03:35:56 PM  Recovery Manager: R estart Recovery complete. (0/0 databa ses 

needed full/partial recovery)  

Media Recovery Replay (1 MB): 30% 50% 80% 100%  

18/01/2007 03:35:57 PM  Recovery Manager: Media Recovery complete for /local/res 

tore/local/notesdata/admin4.nsf, last update applied .  

 

 Backup file /local/restore/local/notesdata/admin4.nsf recovered.  

 

 Taking database /local/notesdata/admin4.nsf offline ...  

 

 

 Restoring database /local/notesdata/admin4.nsf  

  from recovered backup file /local/restore/local/notesdata/admin4.nsf ...  

Databas e file /local/notesdata/admin4.nsf restored from /local/restore/local/not 

esdata/admin4.nsf  

 

 Bringing database /local/notesdata/admin4.nsf online ...  

 

 

Program completed successfully.  

bash - 3.00$  

 

 

f. All content of the database are now rolled forward to the last committed transaction found in 
the last archived transaction log. 

g. Restart Lotus Domino Server 
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12 Backup/Restore Microsoft Exchange Server 

This chapter will describe in details how to use G-OBM to backup your Microsoft Exchange Server 2000 / 2003 
and how you can restore your Microsoft Exchange Server 2000 / 2003 from the backup files. 

12.1 Requirements 

i. Microsoft Exchange Server 2000 with Services Pack 3 and post-SP3 update rollup installed. Please 
refer to http://www.microsoft.com/exchange/ for more information. 
 or 
Microsoft Exchange Server 2003. 

ii. G-OBM must be installed onto the computer running Microsoft Exchange Server 2000 / 2003. 

iii. Data from Microsoft Exchange Server will be backed up to a temporary directory before they are 
sent to the Offsite Backup Server. Please make sure you have sufficient space on your computer 
to store these data when you run the backup job. 

12.2 Overview 

A Microsoft Exchange Server 2000/2003 stores its data in Windows Active Directory as well as in its databases. 
To fully backup a Microsoft Exchange Server 2000/2003, you need to backup the following components: 

i. Windows System State  
 
The Windows System State contains the information about your Windows system, including 
Windows Active Directory. A Microsoft Exchange Server 2000 / 2003 stores some of its 
configuration, e.g. email accounts and mailbox properties, inside Windows Active Directory. It is 
important that Windows Active Directory is backup properly when backing up a Microsoft 
Exchange Server. 
 
Active Directory is stored inside a Windows Server running as Windows domain controller. If your 
Exchange Server is a domain controller, you can simply backup the Windows System State of 
your Exchange Server. If your Exchange Server is running as a member server, you will need to 
install another copy of G-OBM onto the domain controller to backup the Windows System State of 
inside the domain controller. 
 
For more information on Active Directory, please refer to 
http://www.microsoft.com/windows2000/technologies/directory/ad/default.asp  

ii. Microsoft Information Store  
Exchange Server stores all emails and documents inside its databases, which are grouped 
together as storage groups inside Microsoft Information Store. It is important that Microsoft 
Information Store is fully backup when backing your Exchange Server.  

iii. Microsoft Site Replication Service  
Microsoft Site Replication Service is installed automatically when exchange server site replication 
feature is enabled. Microsoft Site Replication stores its runtime and configuration information 
inside its own database. If you are running your Exchange Server with Site Replication Service 
enabled, please make sure that you backup the site replication database as well.  

iv. Microsoft Key Management Service (Exchange 2000 only)  
Similarly, if you have setup your Exchange Server with Key Management Services enabled, please 
make sure that you backup the key management database as well. 

G-OBM will backup your Microsoft Exchange Server by taking the following steps: 

v. Run all Pre-Commands of this backup set 

vi. If the backup type to run is [Database Backup type], 

a. Windows System State will be backed up to a temporary directory specified in its backup set 

http://www.microsoft.com/exchange/
http://www.microsoft.com/windows2000/technologies/directory/ad/default.asp
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b. All exchange database(s) selected are backed up to a temporary directory specified in its 
backup set 

vii. If the backup type to run is [Transaction Log Backup type], 

a. New transaction log extents generated since last backup will be copied to the temporary 
directory 

viii. Remove transaction log extents backed up from the Exchange Server 

ix. Run all Post-Commands of this backup set 

x. Upload all backup files from the temporary directory to the Offsite Backup Server 

xi. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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12.3 How to backup Microsoft Exchange Server 

Please follow the instructions below to backup your Microsoft Exchange Server 2000 / 2003 using G-OBM: 

i. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  
 

 

ii. Create a backup set 

a. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Backup Set] 
 

 

b. Enter a name for your backup set 
 

 

c. Select the database(s) to be backup 
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If this Exchange Server is also a domain controller of this Active Directory, select the 
[System State] checkbox as well. Otherwise, please install G-OBM to the domain controller 
of this Active Directory and select the [System State] checkbox on that computer 

d. Enter a temporary directory for storing the backup files before they are sent to the Offsite 
Backup Server 

e. Set the backup schedule for Database Backup 
 

 

f. Set the backup schedule for Transaction Log Backup 
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day 
transaction log backup by adding more than one daily transaction log backup schedule to 
your backup set) 

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
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(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select the backup type (e.g. Database, Log Files) you would like to perform 
 

 

c. Select [Off-site Backup Server] to start backing up your files to the Offsite Backup Server 
and press the [OK] button 
 

 

d. You should get something similar to the screen shot below. 
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12.4 How to restore Microsoft Exchange Server 

Please follow the instructions below to restore Microsoft Exchange Server 2000 / 2003 from the Gigasoft Offsite 
Backup Server.  

i. Prepare the system for your Exchange Server (if required) 
 
Install the original version of Windows and Exchange Server (with the same level of service pack 
installed as in the original system) back to your computer 

ii. Restore Windows Active Directory (if required) 
 
If you have re-installed Windows, please download the Windows System State backup file, named 
[SystemState.bkf], from the Offsite Backup Server and then use [NTBackup.exe] to restore your 
Windows System State to its backup time from the backup file by following the instructions below: 

a. Run [NTBackup.exe] from [Start] -> [Run] 

b. Press the [Restore Wizard] button and then press the [Next] button 

c. Press the [Import] button and use the [Browse] button to select the backup file 
[SystemState.bkf] downloaded 

d. Select the checkbox next to the description that matches your backup file 

e. Press the [Next] button and then the [Finish] button 

iii. Install G-OBM (if required) 
 
Please refer to the [Installation] section for information on how to install G-OBM onto your 
computer. 

iv. Startup the [Microsoft Information Store] services from Windows Services 

v. Restore exchange database(s) from backup: 

a. Download the database backup files to be restored from the Offsite Backup Server (or find 
the cached copy available in the temporary directory defined in your backup set) and save 
them to your hard disk (please make sure the directory structure is the same as it appears 
on the browser), namely: 

->[C:] 
-->[backup] 
---->[ABC] 
------>[Microsoft Information Store] 
-------->[First Storage Group] 
---------->[Mailbox Store(ABC)] 
--------------->Priv1.edb 
--------------->Priv1.stm 
---------->[Public Folder Store(ABC)] 
--------------->Pub1.edb 
--------------->Pub1.stm 
---------->E0000001.log 

b. If the database to be restored exists on your computer already, please dismount it from the 
services using [Start] -> [Program] -> [Microsoft Exchange] -> [System Manager] 

c. Use [ExchangeRestore.exe] from the [bin] directory under the installation directory of G-
OBM (e.g. C:\Program Files\Gigasoft Online Backup Manager\bin\ExchangeRestore.exe) to 
restore the exchange database(s). 
 
Simply run [ExchangeRestore.exe] to print the usage 

ExchangeRestore.exe Usage: 
C: \ Program Files \ OBM\ bin> ExchangeRestore.exe  
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Microsoft Exchange Server 2000/2003 Backup Recovery Utility  

 

Usage:  

ExchangeRestore DIR=path SERVER=server  TEMP=tempDir [SERVICE=service [STORAGE=st  

orage [DATABASE=database]]]  

 

  DIR        Directory containing all backup files  

  SERVER   Name of Exchange Server to be restored  

  TEMP       Temporary directory to be used during restore  

             Please spec ific a path with plenty of free space  

  SERVICE   Name of Exchange Service to be restored. It must be either  

             "Microsoft Information Store", "Microsoft Key Management Service"  

             or "Microsoft Site Replication Service"  

  STORAGE   Name of storage group to be restored  

  DATABASE  Name of database to be restored  

 

Examples:  

1. To restore an exchange server:  

   ExchangeRestore DIR="C: \ Backup" SERVER="ExchangeServer" TEMP="C: \ Temp" 

 

2. To restore the information store:  

   ExchangeRestore DI R="C: \ Backup" SERVER="ExchangeServer" TEMP="C: \ Temp" 

      SERVICE="Microsoft Information Store"  

 

3. To restore an exchange storage group:  

   ExchangeRestore DIR="C: \ Backup" SERVER="ExchangeServer" TEMP="C: \ Temp" 

      SERVICE="Microsoft Information Store"  STORAGE="StorageGroup1"  

 

4. To restore an exchange database:  

   ExchangeRestore DIR="C: \ Backup" SERVER="ExchangeServer" TEMP="C: \ Temp" 

      SERVICE="Microsoft Information Store" STORAGE="StorageGroup1"  

      DATABASE="Database1"  

where  

  "C: \ Backup"    is  the directory containing all backup files  

  "ExchangeServer"   is the server name of an exchange server  

  "C: \ Temp"           is the temporary directory to be used  

  "StorageGroup1"    is the name of a storage group  

  "Database1"         is the name of a database  

 

d. (Example 1) To restore all databases from backup available in [F:\Backup] to an exchange 
server named [WIN2000SVR] using the temporary directory [F:\Temp], you can use this 
command: 
 
E:\Program Files\Gigasoft Online Backup Manager\bin> ExchangeRestore DIR="F:\Backup" 
TEMP="F:\Temp" SERVER="WIN2000SVR" 

Exchange Server Recovery Example: 
 

E: \ Program Files \ OBM\ bin> ExchangeRestore DIR="F: \ Backup" TEMP="F: \ Temp" 

SERVER="WIN2000SVR" 

 

Microsoft Exchange Server 2000/2003 Backup Recovery Utility  

 

 [Start ] Exchange Server -  'WIN2000SVR'  

  [Start] Service -  'Microsoft Information Store'  

   [Start] Storage Group -  'First Storage Group'  

    [Start] Database -  'Mailbox Store (WIN2000SVR)'  

     Restoring file 'E: \ Program Files \ Exchsrvr \ mdbdata \ priv1.edb' ...  

     Restoring file 'E: \ Program Files \ Exchsrvr \ mdbdata \ priv1.stm' ...  

    [End] Database -  'Mailbox Store (WIN2000SVR)'  

    [Start] Database -  'Public Folder Store (WIN2000SVR)'  

     Restoring file 'E: \ Program Files \ Exchsrvr \ mdbdata \ pub1.edb' ...  

     Restor ing file 'E: \ Program Files \ Exchsrvr \ mdbdata \ pub1.stm' ...  

    [End] Database -  'Public Folder Store (WIN2000SVR)'  

    [Start] Restoring transaction log -  'First Storage Group'  

     Restoring Log File 'F: \ Temp\ restore.tmp \ First Storage Group \ E00000B3.log' . ..  

     Restoring Log File 'F: \ Temp\ restore.tmp \ First Storage Group \ E00000B4.log' ...  

    [End] Restoring transaction log -  'First Storage Group'  

    [Start] Applying transaction log ...  

    [End] Applying transaction log  

   [End] Storage Group -  'First St orage Group'  

ééééé 

   [Start] Storage Group -  'SG2'  

    [Start] Database -  'acct'  

     Restoring file 'E: \ Program Files \ Exchsrvr \ SG2\ acct.edb' ...  

     Restoring file 'E: \ Program Files \ Exchsrvr \ SG2\ acct.stm' ...  

    [End] Database -  'acct'  

    [Start] Rest oring transaction log -  'SG2'  

     Restoring Log File 'F: \ Temp\ restore.tmp \ SG2\ E0100072.log' ...  

     Restoring Log File 'F: \ Temp\ restore.tmp \ SG2\ E0100073.log' ...  

    [End] Restoring transaction log -  'SG2'  

    [Start] Applying transaction log ...  

    [En d] Applying transaction log  

   [End] Storage Group -  'SG2'  

[End] Exchange Server -  'WIN2000SVR'  

 

E: \ Program Files \ OBM\ bin>  

 

e. (Example 2) To restore the database named [mail] in storage group [SG5] from backup 
available in [F:\Backup] to an exchange server named [WIN2000SVR] using the temporary 
directory [F:\Temp], you can use this command: 
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E:\Program Files\Gigasoft Online Backup Manager\bin> ExchangeRestore DIR="F:\Backup" 
TEMP="F:\Temp" SERVER="WIN2000SVR" SERVICE="Microsoft Information Store" 
STORAGE="SG5" DATABASE="mail1"  

Exchange Server Recovery Example: 
 

E: \ Program Files \ OBM\ bin> ExchangeRestore DIR="F: \ Backup" TEMP="F: \ Temp" 

SERVER="WIN2000SVR" SERVICE="Microsoft Information Store" STORAGE="SG5" 

DATABASE="mail"  

 

Microsoft Exchange Server 2000/2003 B ackup Recovery Utility  

 

   [Start] Storage Group -  'SG5'  

    [Start] Database -  'mail'  

     Restoring file 'E: \ Program Files \ Exchsrvr \ SG5\ mail.edb' ...  

     Restoring file 'E: \ Program Files \ Exchsrvr \ SG5\ mail.stm' ...  

    [End] Database -  'mail'  

    [Start]  Restoring transaction log -  'SG5'  

     Restoring Log File 'F: \ Temp\ restore.tmp \ SG5\ E0300012.log' ...  

     Restoring Log File 'F: \ Temp\ restore.tmp \ SG5\ E0300013.log' ...  

    [End] Restoring transaction log -  'SG5'  

    [Start] Applying transaction log ...  

    [End] Applying transaction log  

   [End] Storage Group -  'SG5'  

 

E: \ Program Files \ OBM\ bin>  

f. Repeat the same procedure for each database to be restored to the Exchange Server.  

g. You can use [Start] -> [Program] -> [Administrative Tools] -> [Event Viewer] to check if 
there are any errors generated from the exchange databases restoring activities. 

vi. However, if ExchangeRestore.exe still cannot mount the restored files and returns with strange 
errors, e.g. bad signature, or null errors. Then Exchange server might have incorrectly spooled 
the backup files in the first place. Please try to mount the restored database and log files 
manually by the following instructions: 

a. In MS Exchange System Manager, dismount both the Mailbox Store and Public Folder Store 
from the server. 

b. Copy all the restored database files to the MDBDATA folder (By default, the MDBDATA folder 
is located under C:\Program Files\Excgsrvr\) 

Mailbox Store: 
- priv1.edb 
- priv1.stm 

Public Folder Store: 
- pub1.edb 
- pub1.stm 

c. Run "eseutil /r" to apply the transaction log files to bring the database to a consistent state, 
e.g.: 

C: \ Program Files \ Exchsrvr \ MDBDATA> .. \ bin \ eseutil /r e00  

The above command will try to bring all the databases handled by the transaction log files 
starting with ñe00ò located in ñC:\Program Files\Exchsrvr\MDBDATAò into clean shutdown 
state. 

d. Run "eseutil /p" to repair the database files, e.g.: 

C: \ Program Files \ Exchsrvr \ MDBDATA> .. \ bin \ eseutil /p priv1.edb  

C: \ Program Files \ Exchsrvr \ MDBDATA> .. \ bin \ eseutil /p pub1.edb  

 

e. Mount both Mailbox Store and Public Folder Store to the Server through the MS Exchange 
System Manager. 

 

vii. Completed 
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13 Backup/Restore Windows System State 

This chapter will describe in details how to use G-OBM to backup Windows System State and how you can restore 
your Windows System State from backup. 

13.1 Requirements 

i. Microsoft Windows XP Professional / 2003 

ii. G-OBM must be installed onto the computer containing the system state you want to backup 

iii. Windows system state will be backed up to a temporary file before it is sent to the offsite backup 
server. Please make sure you have sufficient space on your computer to store the temporary file 
when you run the backup job. 

13.2 Overview 

G-OBM will backup your Microsoft Exchange Server by taking the following steps: 

i. Run all Pre-Commands of this backup set 

ii. Windows System State will be backed up to a temporary directory specified in its backup set 

iii. Run all Post-Commands of this backup set 

iv. Upload the Windows System State backup files from the temporary directory to the Offsite 
Backup Server 

v. Remove the Windows System State temporary backup files from the temporary directory if 
[Setting] -> [Temporary Directory for storing backup files] is enabled 



 Gigasoft Holdings Plc 

  

Gigasoft Online Backup 
User Guide 

   

 

Gigasoft Holdings Plc Page 81 of 102 (March 31, 2008) 

 

 

13.3 How to backup Windows System State 

Please follow the instructions below to backup Windows System State using G-OBM: 

i. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  
 

 

ii. Create a backup set  

a. From the Menu, Choose [Backup Set] -> [New] -> [System State Backup Set] 
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b. Enter a name for your backup set 
 

 

c. Use the [Change] button to configure the [Temporary directory for storing backup files] 
setting and check the [Remove temporary files after backup] if you want temporary files to 
be removed automatically after backup 
 

 
 

d. Enter a temporary directory for storing the backup files before they are sent to the Offsite 
Backup Server 

e. Set the backup schedule for this backup set 
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f. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select [Off-site Backup Server] to start backing up your files to the Offsite Backup Server 
and press the [OK] button 
 



 Gigasoft Holdings Plc 

  

Gigasoft Online Backup 
User Guide 

   

 

Gigasoft Holdings Plc Page 84 of 102 (March 31, 2008) 

 

 

 

c. You should get something similar to the screen shot below. 
 

 

13.4 How to restore Windows System State 

Please follow the instructions below to restore Windows System State from the Offsite Backup Server.  

i. Install G-OBM (if required) 
 
Please refer to the [Installation] section for information on how to install G-OBM onto your 
computer. 

ii. Restore the Windows System State Backup File (i.e. SystemState.bkf) from the backup server 

iii. Use [NTBackup.exe] to restore your Windows System State to its backup time from the backup 
file by following the instructions below: 

a. Run [NTBackup.exe] from [Start] -> [Run] 

b. Press the [Restore Wizard] button and then press the [Next] button 

c. Press the [Import] button and use the [Browse] button to select the backup file 
[SystemState.bkf] downloaded 

d. Select the checkbox next to the description that matches your backup file 

e. Press the [Next] button and then the [Finish] button 

iv. Completed 
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14 Backup/Restore Individual Brick Level Backup for Microsoft 

Exchange Server 

14.1 Requirements 

i. Microsoft Exchange Server 2000 with Services Pack 3 and post-SP3 update rollup installed. Please 
refer to http://www.microsoft.com/exchange/ for more information. 
 or 
Microsoft Exchange Server 2003. 

ii. G-OBM must be installed onto the computer running Microsoft Exchange Server 2000 / 2003. 

14.2 Overview 

Brick Level Backup for Microsoft Exchange Server is not designed to fully protect an Exchange server, but to 
facilitate easy backup and fast restore of individual emails, contacts, calendars, tasks etc. The brick level restore 
cannot fully recover the Information Store after a disaster. If used, a brick level backup must be utilized in 
conjunction with full Information Store Backup, in order to fully protect the exchange server. 

14.3 Granting Privileges 

Brick Level Backup requires ñFull Mailbox Accessò permission for the user running G-OBM. Normally, G-OBM can 
acquire the permission on itôs own but if you encounter óAccess Deniedô errors you need to manually grant access 
privileges to the user running G-OBM using one of the following instructions below: 

For one specific mailbox  

Use the following procedure to grant access to an Exchange 2000 or an Exchange 2003 mailbox: 

1 Start Active Directory Users and Computers. 

2 On the View menu, ensure that the Advanced Features check box is selected. 

3 Right-click the user whose mailbox you want to give permissions to and choose Properties. 

4 On the Exchange Advanced tab, click Mailbox Rights. 

5 Notice that the Domain Admins and Enterprise Admins have both been given Deny access to Full Mailbox 
access. 

6 Click Add, click the user or group who you want to have access to this mailbox, and then click OK. 

7 Be sure that the user or group is selected in the Name box. 

8 In the Permissions list, click Allow next to Full Mailbox Access, and then click OK. 

9 Click Ok all the way out. 

10 Restart the Microsoft Exchange Information Store. 

For mailboxes lo cated within a specific mailbox store  

Use the following procedure to grant access to an Exchange 2000 or an Exchange 2003 mailbox found on a 
specific mailbox store: 

1 Start Exchange System Manager. 

http://www.microsoft.com/exchange/
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2 Drill down to your server object within the appropriate Administrative Group. Expand the server object 
and find the required mailbox store within the appropriate Storage Group. Right-click it and choose 
Properties. 

3 In the Properties window go to the Security tab. 

4 Click Add, click the user or group who you want to have access to the mailboxes, and then click OK. 

5 Be sure that the user or group is selected in the Name box. 

6 In the Permissions list, click Allow next to Full Control, and then click OK. 

7 Click 'Apply' and 'OK' 

8 Restart the Microsoft Exchange Information Store. 

For mailboxes located within a specific server  

1 Start Exchange System Manager. 

2 Drill down to your server object within the appropriate Administrative Group. Right-click it and choose 
Properties. 

3 In the Properties window go to the Security tab. 

4 Click Add, click the user or group who you want to have access to the mailboxes, and then click OK. 

5 Be sure that the user or group is selected in the Name box. 

6 In the Permissions list, click Allow next to Full Control, and then click OK. 

7 Click Ok all the way out. 

8 Restart the Microsoft Exchange Information Store. 
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14.4 How to backup Individual Brick Level Backup 

Please follow the instructions below to backup all individual items within your Microsoft Exchange Server 2000 / 
2003 using G-OBM: 

i. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  
 

 

ii. Create a backup set 

a. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Mail Level Backup Set] 
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b. Enter a name for your backup set 
 

 

c. Select the email account(s) to backup 
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You can drill down to select individual items. 

d. Set the backup schedule 
 

 
 

 
 

e. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
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(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select [Offsite Backup Server] to start backing up your files to the Offsite Backup Server 
and press the [OK] button 
 

 

c. You should get something similar to the screen shot below. 
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14.5 How to restore Individual Brick Level Backup 

Please follow the instructions below to restore individual emails, contacts, calendars, tasks etc. from the Offsite 
Backup Server back into your exchange server. Please note that individual brick level can only be restored using 
the G-OBM client. 

i. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  
 

 

ii. Choose the [Restore] tab and select the items you want to restore 
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iii. Press the [Restore Files] button 

 

iv. Press [Start] 

 

 

v. Restore complete. Please logon to exchange to get the restored items. 
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15 Backup/Restore MySQL Server 

This chapter will describe in details how to use G-OBM to backup your MySQL server and how you can restore 
your MySQL server from the database backup files. 

15.1 Requirements 

i. G-OBM must be installed onto the computer running MySQL server. 

ii. Data from MySQL server will be backed up to a temporary directory before they are sent to the 
Offsite Backup Server. Please make sure you have sufficient space on your computer to store 
these data when you run the backup job. 

iii. There must be a MySQL account can be used to connect from localhost. 
 
Add two new MySQL accounts for Backup Manager 
 
mysql> GRANT ALL PRIVILEGES ON *.* TO 'root'@'localhost' 
     -> IDENTIFIED BY 'some_pass'; 
mysql> GRANT ALL PRIVILEGES ON *.* TO 'root'@'localhost.localdomain' 
     -> IDENTIFIED BY 'some_pass'; 
mysql> FLUSH PRIVILEGES; 
 
They are superuser accounts with full privileges to do anything with a password of some_pass. 

15.2 Overview 

G-OBM will backup your MySQL server by taking the following steps: 

i. Run all Pre-Commands of this backup set 

ii. All database(s) (either local or external) selected are backed up to a temporary directory specified 
in its backup set  

iii. Run all Post-Commands of this backup set 

iv. Upload all backup files from the temporary directory to the Offsite Backup Server 

v. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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15.3 How to backup MySQL server on Windows 

Please follow the instructions below to backup your MySQL server using G-OBM: 

i. Open G-OBM 
 
Right click G-OBM icon available in the system tray and choose [Open]  
 

 

ii. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set] 
Create a backup set 

a. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set] 
 
 

 

b. Enter a name for your backup set 
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c. Enter the root password, the MySQL server TCP/IP port number and the path to MySQL 
backup utility (mysqldump) 

d. Select the database(s) to be backup 
 

 

e. Enter a temporary directory for storing the backup files before they are sent to the Offsite 
Backup Server, e.g. C:\Backup\MySQL 

f. Set the backup schedule for Database Backup 
 

 

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 
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iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 

(►) 

b. Select [Off-site Backup Server] to start backing up your files to the Offsite Backup Server 
and press the [OK] button 
 

 

c. You should get something similar to the screen shot below. 
 

 

 

15.4 How to restore MySQL server 

Please follow the instructions below to restore MySQL server from the Gigasoft Offsite Backup Server. 

i. Download the database backup files to be restored from the Offsite Backup Server 
 
Please refer to the [5.3 Restoring file] section for information on how to download backup files 
from the Offsite Backup Server. 

ii. Restore the database named [db_name] from the database backup file [db_name.sql]: 

a. Connect to the MySQL server 
 
(Windows) C:\> mysql 
(Linux) [root@server ~]# mysql 

b. Create the database to be restored  
 
mysql> CREATE DATABASE IF NOT EXISTS db_name 
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c.Restore the database backup file back into the MySQL server 
 
mysql> use db_name ; 
mysql> source db_name.sql ; 
 
If db_name.sql is not located in the current directory, please specify the full path to the 
db_name.sql file in the command above. 

iii. Repeat the same procedure for each database to be restored to the MySQL Server. 

iv. Completed 
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16 Email Reporting 

The Gigasoft Offsite Backup Server makes use of the email system to keep you informed with the status of your 
backup activities. Please make sure your contact information within the backup system is correct to receive the 
reports described in this chapter. 

16.1 Backup Job Report 

For each backup job you have run, a backup job report will be sent to you by email. This report contains a 
summary for the backup job that was run and a full listing of all files being backed up by the backup job. The 
backup summary report contains the following information:  

Sample Backup Summary Report  

 
 

Key  Description  

Backup Time The time when the backup job ran 

Backup Status The overall status of the backup job. Normally, you should see ñBackup 
finished successfullyò in this field. If you happen to get something else, 
please consult the attached full report for more information. 

New Files Total number and size of backup files added to your backup set 

Updated Files Total number and size of backup files updated in your backup set 

Deleted Files Total number and size of backup files deleted from your backup set 

Moved Files Total number and size of backup files relocated in your backup set 

  

Login Name Login name 

Alias Alias 

Language Preferred Language for your backup report 

Contact Email Address that will be used to contact you 

  

Backup Source All files/directories that will be backed up 
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Backup Data Size The total backup data stored in the data area 

Retention Area Size The total backup data stored in the retention area. Old copies of updated 
or deleted backup files are retained in the retention area for the number of 
days as specified by the retention policy of the backup set before they are 
removed from the system. 

Backup Quota Backup Quota 

Remaining Quota Remaining Quota 

 

The full backup report, which contains a full listing of all files backed up by the backup job, is attached to the 
backup job report email as a zip file. You need to unzip it before you can read the full report.  

Sample Report  

 
 

Key  Description  

Backup Set The name of the backup set 

Backup Job The name of the backup job (which is the start time of the backup job) 

Backup Status The overall status of the backup job. Normally, you should see ñBackup 
finished successfullyò in this field. If you happen to get something else, 
please consult the attached full report for more information. 

Backup Time The time when the backup job ran 

  

Backup Log All messages logged when running this backup job 

New Files Total number and size of backup files added to your backup set 

Updated Files Total number and size of backup files updated in your backup set 

Deleted Files Total number and size of backup files deleted from your backup set 

Moved Files Total number and size of backup files relocated in your backup set 

  

New File List Full list of all backup files added to your backup set 

Updated File List Full list of all backup files updated in your backup set 

Deleted File List Full list of all backup files deleted from your backup set 

Moved File List Full list of all backup files relocated in your backup set 
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16.2 Setting Change Report 

After you have updated your user profile or backup setting, a setting change report will be sent to you. This 
report allows you to track record of the changes that have been made to your backup account.  

Sample R eport  

 
 

Key  Description  

Login Name  Login name 

Alias Alias 

Language Preferred Language for your backup reports 

Contact Email Address that will be used to contact you 

Backup Quota Backup Quota 

  

Backup Source(s) All backup sources of the backup set 

Backup Schedule(s) All backup schedules of the backup set 

Filter(s) All backup filters of the backup set 

Retention Policy The retention policy of the backup set 

Transfer Size The transfer block size of the backup set 

Pre-Command(s) All Pre-Command(s) of the backup set 

Post-Command(s) All Post-Command(s) of the backup set 
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16.3 Inactive User Reminder 

You will receive an inactive user reminder in email if your account has been left inactive for the period of 7 days 
(or the period specified by the system administrator). This is to remain you that you have not been running 
backup for more 7 days. If you are a free trial user, your account will be removed from the system automatically 
if the system can track no records of your backup activities in the next 30 days after receiving this report.  

Sample Report  

 
 

Key  Description  

Login Name  Login name 

Alias Alias 

Language Preferred Language for your backup reports 

Contact Email Address that will be used to contact you 

Backup Quota Backup Quota 

  

Last Login Time The last time you logon to the backup system 

Last Backup Time The last time you ran a backup job  
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17 Further Information 

17.1 FAQs  

Please see if your question has already been answered in our FAQs available on our website. 

http://www.gigasoftdatabackup.co.uk/files/faq.pdf 

17.2 Contact Us  

You can contact Gigasoft Holdings Plc by the following methods. 

¶ http://www.gigasoftdatabackup.co.uk 

¶ Email support@gigasoftholdings.com 

¶ Call 01279 465654 

 

http://www.gigasoftdatabackup.co.uk/
mailto:support@gigasoftholdings.com

